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Guide Usage and Disclosures

Guide Information

This guide is designed based on the Oracle Cloud HCM delivered setups; some
fields may differ from your instance configurations. For example, some fields may
be required in this guide that are not required in your instance. Additionally, some
of the training topics discussed in this guide may not apply to your organization,
but we know you'll find it helpful. If you would like a custom guide for your
organization, please contact Megan Ketter at mketter@camptratech.com.

How To Use This Guide
This guide is intended to assist Admin users with their day-to-day tasks in Oracle
Cloud. A few notes before you begin:

1. Any fields with an asterisk are required fields.

2. Based on your configurations, approval workflows may in place for the
training topics below; those tasks would need to be approved before the
additions or updates are visible in your instance.

You may have specific flexfields in your instance that require inputs; this guide is a
generic tool and will not include those specific flexfields. You will see those fields as
a context segment or not visible at all in our Oracle instance.
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Overall Process Flow
Before we begin with the training content, it's important to understand the overall
process flow of information in Oracle Cloud for the Recruiting module.

Oracle Recruiting Cloud provides a platform to recruiters and hiring managers to find the
best candidates for a job. Recruiting provides tools to source and nurture candidates,
create, and manage job requisitions, screen, and select candidates, create, and manage job
offers, and onboard new employees into the organization. It also provides career sites for
employees and external candidates to search, discover, and apply to jobs using a smooth
application process.

For example, below is the ‘Recruiting Process Life Cycle’

HM REC SOURCER CAN
initiates job completes job creates apply to jobs
requisition requisition and campaigns and
candidate pools

REC/COLL
manages
candidate

posts responses

HR SPEC
completes hiring
activities and
assignment within
HCM

REC/COLL REC/HM REC CAN
HM/CAN conducts creates and views and accepts
arranges interviews and extends job offer; offer online and
interview activity collects interview COLL finalizes completes pre-
feedback pre-hire tasks hire tasks

REC - Recruiter or Hiring Team

HM - Hiring Manager

CAN - Candidate

COLL - Collaborators

SOURCER - Sourcing, recruitment marketing
HR SPEC - HR Specialist




Glossary of Terms

Here we've included common terms associated to the Recruiting module. Please review
the terms below to familiarize yourself with the Oracle Cloud terms used throughout this
guide.

Candidate
< Anindividual who has applied for a job with the organization
Candidate Profile

¢ A candidate profile contains information such as candidate personal information,
work experience, employment preferences.

Job Requisition Template

¢ Ajob requisition template provides a way to facilitate the creation of job
requisitions by defaulting values in several fields. Job requisition templates contain
the same fields as job requisitions. If a job requisition is created from a requisition
template, all fields for which a value is set in the template will be defaulted with the
template's value.

Custom Fields

¢ Custom fields also known as descriptive flex fields within the application are
additional set of fields that are created for capturing information that business
needs for job requisition and/or job offer. These are used in addition to the seeded
fields provide by oracle.

Job Application Flow

< Ajob application flow is a sequence of pages that candidates complete when they
apply for a job or when they provide additional information after they have applied
to ajob. A job application flow contains sections, and each section contains blocks
of information.

Candidate Selection Process

¢ The candidate selection process provides the framework to move candidates
through the hiring process to evaluate and find the best candidates for a job.

Career Site

< Acareer site is a website where an organization posts jobs for positions to be filled.
External candidates interact with a career site when they search for jobs, apply for




jobs, create a profile, share job details, get referred for a job, manage their job
applications and talent community settings.

Prospects

< Prospects are people who were referred for a job requisition or added to a job
requisition but who haven't yet completed their job application.

Interview Templates

< Interview schedule templates are created to help recruiters and hiring managers
save time when they create interview schedules for job requisitions. For example,
you can specify a commonly used conference room or location or the URL and dial-
in information.

Questionnaires

< Questionnaires contain questions that can be attached to a job requisition and is
available to candidates to answer when they apply for a job.

Job Offer

< You create job offers by providing details such as proposed start date, job
assignment, salary, or other compensation. You extend job offers to candidates.
Candidates receive the offers, consider the content, and respond to the offers by
either accepting or declining them.

Job Offer Template

¢ This template provides the formatting, branding, and most of the text that each
candidate will see when they receive their offer letter.




Admin Work Area Navigation
Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and
Candidate Experience>Functional Areas

To manage activities related to Recruiting Administration, from the home screen,
click My Enterprise

Good morning, PROD IMPLADMIN!

Service Help Desk

QUICK ACTIONS

Click My Enterprise

»  Medical Plan Comparison

' ® li¥, 04
2| My Public Info

Diractory Time and Career and Personal
Absences Performance Information
Change Photo

Stiore Dotd A ©) L] g fre

Learning Benefits My Benefits Company Benefits Opportunity
Summary Portal Marketplace

(=] Document Delivery Prafar:

Eligible Jobs @ % D’lﬁu

=4

4’,

Current Jobs Safety Incidents Performance Camptra Support
Resignation Portal

Show More

Click Setup and Maintenance

Good morning, PROD IMPLADMIN!

& Service Help Desk Supply Chain Planning My Enterprise
QUICK ACTIONS

vailable Features

oo % +
New Features Feature Updates Setup and
Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago x 2 weeks ago x 2 weeks ago x 1 month ago
T ACTION REQUIRED ACTION REQUIRED. ACTION REQUIRED. ACTIGN REQUIRED.
EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 Test 1043 Manu:
241 Manual Task Approval Manual Task Approval Manual Task Approval Approval For Ug
For Verify Retroactive For Verify Retroactive For Verify Payroll File >
Report Notification Report Validation Report

103 - EEE




Change setup to Recruiting and Candidate Experience

Compensation Menagement

Setup: Compensation Managemsiv &

Click Dropdown

| Finandals

Functional Areas Fusion Accounting Hub
. Manufacturing and Supply Crain Materals Nanagement
Inital Users [ ~ ] Initial Users
Projec: Finandal Management
Enterprss Profie Recruting anc Candidete Experience [ -] View v Formet v

* Logal Structures Senvice Task Scope

Workfurce Deployment
* Organization Structures

Workdorce Development Click Recruiting and Candidate Experience

* Financial Reportng Structures

* Workorcs Struckres srres (D)
* Users and Securiy ey - ]

HCM Data Loader srres (D)

Worldorcs Information sraree (BB
* Basic Payrol ©
* Bse Py [ -]
* Benefts srarcs €D
* Inevidual Compensation ey~ |

Worklorcz Compensation [ +]
* Total Conpensalion Sta'ements [+ ]

All the tasks related to Recruiting Administration are now available

Search Tasks ‘ ‘E‘

Functional Areas Change Feature OptIn
Organization Structures Shored Bl o
Initial Users
* Financial Reporting Structures — . ]
view w Format v Freeze Wrap  Show | Required Tasks v

* VWerkforce Structures shares I Task

Workforce Profiles hares Run User and Roles Synchronization Process
* Users and Security shares B Columns Hidden 4
™ Workforce Information sharze (D

Benefite sharea (R

HCM Data Exchange =
* Recruiting and Candidale Experience Management =
~ Job Requisitions =
* Candidate Experience =
* Candidate Job Applications =

Job Offers =

Source Candidates =

Application Extensions et @) ED

Create Job Requisition Templates

Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and
Candidate Experience>Functional Areas>Job Requisitions>Job Requisition
Templates>Actions>Activate

From the home screen, click My Enterprise




Good morning,

PROD IMPLADMIN!

QUICK ACTIONS

Click My Enterprise

Medical Plan Comparison

©

Time and
Absences

ﬁﬁ ¢
Career and
Performance

Sublic Info
Directory Journeys Personal
Information

Change Photo

®

Learning

My Benefits
Summary

kg

Company Benefits
Portal

el

Oppertunity
Marketplace

nal Info Conalis

Document Delivery Prefere

Eligible Jobs

(R

Current Jobs

2

il

Performance

4’,

Safety Incidents Camptra Support

Resignation Portal

Chain Planning My Enter

QUICK ACTIONS

Available

<J

New Faaturas

7
Do

Feature Updates

+

Offerings Setup and

Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Retroactive

Report

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Retroactive

Notification Report

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Payroll
Validation Report

=)

1 month ago

ACTION REQUIRED

Test 1043 Manu:
Approval For Uy

File >

|

Change setup to Recruiting and Candidate Experience




Compensation Management

Setup: Compensation Managepss

Click Dropdown

" Finandials
Functional Areas Fusion Accounting Hub

. Manuacturing and Supply Crain Malerils Nanagement
Intial Users

Initial Users.
Projec: Finandal Management
* Enterpriss Profile

Recruiing anc Candidate Experience View v Formal v

Senvice Task

* Legal Structures

Workfurce Deployment

* Organization Structures
Workforce Development

* Fnancial Reportng Structures
* Workorcs Structures
* Users and Securty

HCM Data Loader

Workforcs Information

* Basic Payroll [ -]

* Bse Py [ -]

* Banefits

* Inevidual Compensation s 6D
Worklorcs Compensation [~]

* Total Conpensalion Sta'ements [+ ]

Freeze

Scope

Search Tasks

Functional Areas View C:
* Initial Users srare: (D)
* Enterprise Profile snaree (B
* Legal Structures snaree (D)
* Organization Structures shares (KD
* Financial Reporting Structures shares (K
* Workforce Structures snerzc (B
Workforce Profiles srares ()
* Users and Security srares BB
* Workforce Information srares KD
Beneits shares (K
HCM Data Exchange =
* Recruiting and Candidate Experience Management =
-
" Candidate Experience Click Job Requisitions =
* Candidate Job Applications =

Job Requisitions

View v Format v is| Detach

Task
Job Requisition Templates
Job Requisition Descriptive Flexfields

Columns Hidden 3

Next, click Job Requisition Templates

—




Setup: Recruiting and Candidate Experience &

Search Tasks ‘ ‘E‘

Functional Areas View Configuration
* Initial Users shared (B Job Requisitions
~ Enterprise Profile shared (B View w Format w Show | Required Tasks v
* Legal Structures Shared (D Task
* Organization Structures snares (B2
Job Requisition Descriptive Flexfieids
B Click Job Requisition Templates
Financial Reporting Structures snares (D) Columns Hidden 3 q p!
* Workforce Structures snares (B2
Workforce Profiles ey ~ |
= Users and Security ey ~ |
* Workforce Information shares (B0
Benefts shares 0

HCM Data Exchange
™ Recruiting and Candidate Experience Management
* Job Requisitions

* Gandidats Experiance

* Candidate Job Applications

In this screen, we can review the existing templates and create a new template. To
create a new job requisition, expand Create then, click Standalone

¢ Job Requisition Templates

FEVET, &

Status  Draf. X Active X

s -

Vigw v

Code Type Status Last Updated Date Created By

ERPO| " Click Standalone Standalone Draft 317120 IMPLADMIN [ ~ ]
ERPO lesource Partner Standalone Aciive 33020 IMPLADMIN [ - ]
NK_.C Junior Consultant Position Active 1118022 Recruiter, Jack [ - ]
JC_NKO1 Junior Consultant lob Active 11822 Recuiter, Jack [ -]
JC_NK Junior Consultant Standalone Active 11822 Recuiter, Jack [ -]
PA_Network P Netviorl SPecialist Position Active 221122 Recruiter, Jack [ - ]
PA_Ass Con... PA Associate Consultant Template Standalone Active 3122 Recriter, Jack [ - ]
PA_Trial PA Trial Standalone Aciive 212322 Recuiter, Jack [ - ]
NKO1_SA NKD1_Senior Accountant Standalone Aciive 124122 Recruiter, Jack [ -]
SS_AB Solution Specialists Job Active 11921 abhatnagar@cam... [ - ]
NK_SA NK Senior Accountant lob Active 1124122 Recuiter, Jack [ -]
TMPACC  Template - Job Accountant Standalone Draft 83121 Recniter, Jack (-]
NetwrkSpec-NK Network Specialist-NK Standalone Active 2125122 Recriter, Jack [ - ]

Enter the Basic Info, Hiring Team, Posting Structure, Offer Info, Budget,
Compensation, Job Profile, Additional Details, Posting Description, and
Configuration details

]

—



Create Job Requisition Template: Details

e Sl A LA

e 4 Basicifo Complete the information below,
Details Status Draft

Rectuting Type | Professional V]

Business Unit | Camptra US Business Unit v

“Code ‘ TMP_HRD

“Name ‘Temmate - Job Human Resources Director ‘

Requisition Tl | |

Display in Organization Chart v/

Languages American English (Default) &

A g Team

Hiting Manager Recruiter

!” Rakesh Jhindal v g Michael Burke v

Add Collaberator Type

Organization | Camptra Org v
Primary Location | CA, United States v

Other Locations = Acd

Once the below information is entered, click Save

Create Job Requisition Template: Details

FEVERIETIE
Click Save

le 4 335ic Info

Details Status Draft

Rectuiting Type | Professional V]

Business Unit | Camptra US Business Unit v

*Code ‘TMP,HRD ‘

*Name ‘Temmats - Job Human Resources Director ‘

Requisition Title | |

Display in Organization Chart v/

Languages American English (Default) &5

4 Hiring Team

Hiring Manager Recruiter

!,, Rakesh Jhindal v g Michael Burke v

Add Collaborator Type

Organization | Camptra Org v
Primary Location | CA, United States v

Other Locations = Add

The Job Requisition Template will be saved in Draft status. To activate the Job
Requisition Template, expand Actions, click Activate Template then Continue

]
1|

—



{ Template - Job Human Resources Director: Details

I 4 355 nfo &

Details

2 Job Formatting

Status Draft
Rectuiting Type Professional
Code TMP_HRD

Requisition Tite

Display in Organization Chart ¥/

Name Template - Job Human Resources Director

Languages American English (Default)

4 diing Teem 4
Hiring Manager

Rakesh Jhindal
Marager

Organizatien Camptra Org

4 20siing Structue. &

Primary Locaticn CA, United States

Other Lacations
Job Family

Job Functicn

Recruiter

Michael Burke
Manager

Click Activate Template

Actions ¥

Aclvete Template

Hpply Jeb

Freview Template

Duplicate Temgiale

Delate Templatz

Now activated, the Job Requisition Template will be available to Hiring Managers
and Recruiters to create Job Requisition(s). All the information in the template will
be populated in the Job Requisition when the template is selected.

Create Job Requisition Custom Fields

Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and
Candidate Experience>Functional Areas>Job Requisitions>Job Requisition

Descriptive Flexfields

From the home screen, click My Enterprise

Good morning, PROD IMPLADMIN!

¢ Service Help Desk Supply Chain Planning My Enterprise

QUICK ACTIONS APPS

> Medical Plan Comparisan

588

My Public Info
4 Directory Journeys
I, Change Photo

Share Data Accass

® s

Learning Benefits

Share Personal Info

Document Delivery Preferences

@) oy
Eligible Jobs =Y

Current Jobs

%) Resignation

Show More

Click Setup and Maintenance

—

Safety Incidents

Click My Enterprise

G

Time and
Absences

My Benefits
Surnmary

il

Performance

Others

i

Career and
Performance

it

Company Benefits

Camptra Support
Portal

O

4

Personal
Information

e

Opportunity
Marketplace

+

]
12 |



Good morning, PROD IMPLADMIN!

Service
QUICK ACTIONS

ailable Features
oo
Offerings New Features Festure Updates Setup and
Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago 2 weeks ago 2 weeks ago 1 month ago

ACTION REQUIRED. ACTION REQUIRED. ACTION REQUIRED. AcTIoN RequIRED.

EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 Test 1043 Manu:
Manual Task Approval | Manual Task Approval Approval For Ug
For Verify Retro For Verify Payroll File >
Report Validation Report

103
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Change setup to Recruiting and Candidate Experience

Setup: Compensation Managemsi? @

Compensation Menagement

Click Dropdown

e St [[a)

€ nitalUsers

"] Finandials
Functional Areas Fusion Accounting Hub

. Manufacturing and Supply Crain Malerials Management
Inital Users

Frojec: Financial Management

* Enterprise Profle = View v Formal v Freeze

Recruiting anc Candidate Experience Defach Wrzp  Show

Service

* Lagal Stuctures Tesk Scope
Workforce Deployment
* Organization Structures

Workforce Development

* Financial Reportng Structures

* Viorkfores Struchures srares (B2
* Users and Securiy srares 2

HCM Data Loader Eeey -

Workfores Information srares )
* Basic Payrol [ ~ ]
* Base Py [ -]
* Beneits e D)
* Individua Compensation srares B
Workforc2 Compensation [ ]
* Total Corensafon Stzements [ +]

Under Functional Areas, click Job Requisitions




Setup: Recruiting and Candidate Experience &

Functional Areas

* Initial Users

* Enterprise Profile

* Legal Structures

* Organization Structuras

* Financial Reporting Structures

* Workforce Structures
Workforce Profiles

* Users and Security

* Workforce Information
Benefts
HCM Data Exchange

* Recruiting and Candidate Experience Management

ob Requisitions

* Candidate Experience

Click Job Requisitions

" Candidate Job Applications

View C Search Tasks ‘ ‘ 0\|
sares BB Job Requisitions
Sharee (D View v Format v Detach Show | Required Tasks v
srares 6 Task
Job Requisition Templates
srares (X0
Job Requisition Descriptive Flexfields
srares (D Columns Hidden 3
snaree (D
srares (KD
srares (K
srzres (D
sraree (5D
=
=
=

Next, click Job Requisition Descriptive Flexfields

Functional Areas

* Initial Users

* Enterprise Profle

* Legal Structures

* Organization Structures

* Financial Reporting Structures

* Workforce Structures
Workforce Profies

™ Users and Security

™ Workdorce Information
Benefits
HCM Dala Exchange

* Recuting and Candidats Experience Management

* Job Requisitions

* Candidate Experience

* Candidate Job Appiications

sraree B
srares (8B
croree B
sraree B
srores B
sraree D)
snares ()
srares ()
sraree B
sraree B

Job Requisitions

[ Detach Wrap  Show

View v Format v

Task S

Job Requisiton Templates

Job Requisition Descriptive Flexiel

Columns Hidden 3

Click Job Requisition
Descriptive Flexfields

Next, click the Pencil icon

—




Job Requisition Descriptive Flexfields &

Search Results Click Pencil Icon

Actions w View v Format v Freeze [yl Detach Wrap
Name Type Module Flexfield Code Entity Usages  Description Deployment D"P"’""'*";f""’ Deployment Date
Job Requisition Descripti.. Descriptive Flexfield Job Requisitions Core IRC_REQUISITIONS_DFF Additional fields for requis... 4 §/15/22 .03 PM
. o ¢
Next, click the Pencil icon
Job Requisition Descriptive Flexfields @
Search Results Click Pencil Icon
Actions w  View v Format v Wrap Deploy Flexfield
. - Deployment Deployment Error
Name Type Module Flexfield Code Entity Usages  Description Kot Nosags Deployment Date
Job Requisition Descripti.. Descriptive Flexfield Job Requisitions Core IRC_REQUISITIONS_DFF ‘Additional fields for requis. ... 4 815/22 7:.03 PM

Click the + icon




Job Requisition Descriptive Flexfislds @
Name Job Requisition Descriptive Flexfield

Flexfizld Code  IRC_REQUISTIONS_CFF

Description | Addiioral fields for requisiton

Global Segments

Freeze  [3] Defach Wrap

Actins v View v Fomat v

" Sequaac? Name Table Column Value Set Promot
ATTRIBJTE_CHAR1 DPT_LOV Depariment
Columns Hidden 9
Cantext Segment
APIName
Value Set ‘ v

Default Type

[] Required

* Display Type | Hidden v

Context Sensitive Segments

Specify sagments basad on he defned context value.

Manage Contexts H Manage Segment Labels ] Ee“ Save and Close ”

Segment Separato

Application  Recruiting

Module Job Requistions Core

[] BiEnsbled
Bl Label

Definition Help Text

Instruction Help Tex

Enter the information below and click Create Value Set

Create Segment @

4
Flexield Name Job Raquisiton Descristive Flexfield

* Name | Feferrsl Source
* Code | REF_SRC

Column Assignment

* Data Typ

Validation
Value Set Descripton
Initial Default
Default Typ
Display Properties

* Prompt | Referral Souce

* Display Typs | TextArea v

ows ||

Display Height

] Reateoniy

Business Intelligence

nter/Information Below,

SO\

o ] s o] ]

Flexfled Code IRC_REQUISITIONS_DFF

Description

 Enatled

| Create Value Set

Range Tyre

Click Create Value Set

(] Reaured

T S
. S

Bl Lebel

Enter the Value Set Code and select Recruiting for the Module field

—

16




Creat Value Set @ Enter Value Set Code

Manage Values

'|Va\ue Set Code ‘ Referral Source

Description ‘ ‘
* Module | Recruiting ‘ v l

* Validation Type .

* Value Data Type Recruiting APPLICATION IRC
AE Absences Click Recruiting HomLOcAEEpiMtADsences
AE Absences Common LBA HemLocAEADSCommon
AE Absences In Lieu LBA HemLocAEAbsInLieu
AE Absences Maternity and Paterity LBA HemLocAEAbsMatPatAdop
AE Absences Miltary LBA HemLocAEAbsMilitary
AE Absences Others LBA HemLocAEAbSOther
AE Absences Parental LBA HemLocAEADSParental .
Search.

Enter the additional Information and click Save and Close

Create Value Set @) Manage Values

o o

* Value Set Code ‘ Referral Source ‘

Click Save and Close

Description ‘ ‘

* Module ‘Re:rumng ‘ v l

* Validation Type | Independent v
* Value Data Type

(7] Securty enabled

Data Security Resource Name ‘ Edit Data Security

Definition

* Value Sublype
* Maximum Length
Minimum Value :
Maximum Value :

7] Unpercase only

[ zeofil

Lastly, from the Job Requisition Descriptive Flexfields home screen, click Deploy
Flexfield to deploy the flexfield in the instance




Job Requisition Descriptive Flexfields &

Click Deploy Flexfield

Search Results

Actions v View w Formatw /' Freeze [y Detach Wrap ‘Dep\nyF\exﬁeln

. - Deployment Deployment Error
Name Type Module Flexfield Code Entity Usages  Description Statiis Message Deployment Date

‘ Additional fields for requis. 4 ‘ ‘ 8/15/22 7:03 PM

Job Requisition Descripti . Descriptive Flexfield  Job Req Core IRC_REQUISITIONS_DFF

Edit List of Values For Existing Custom Field
Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and
Candidate Experience>Functional Areas>Job Requisitions>Job Requisition

Descriptive Flexfields

From the home screen, click My Enterprise

Good morning, PROD IMPLADMIN!

< Service Help Desk Supply Chain Planning My Enterprise Tools Configuration

QUICK ACTIONS APPS Click My Enterprise

| g 52 ® il 04

ly Public Info )
Directory s Time and Career and Personal
Absences Performance Information

df; Change Photo

ats Dareeridl Info Learning Benefits My Benefits Company Benefits Opportunity
Sumnmary Portal Marketplace

[=] Document Delivery Preferences

Eligible Jobs @ D’ﬁu +

Current Jobs Safety Incidents Performance Camptra Support
Portal

Resignation

Show More

Click Setup and Maintenance




Good morning, PROD IMPLADMIN!

Service
QUICK ACTIONS

ailable Features
oo
Offerings New Features Festure Updates Setup and
Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago 2 weeks ago 2 weeks ago 1 month ago

ACTION REQUIRED. ACTION REQUIRED. ACTION REQUIRED. AcTIoN RequIRED.

EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 Test 1043 Manu:
Manual Task Approval | Manual Task Approval Approval For Ug
For Verify Retro For Verify Payroll File >
Report Validation Report

103
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Change setup to Recruiting and Candidate Experience

Setup: Compensation Managemsi? @

Compensation Menagement

Click Dropdown

e St [[a)

€ nitalUsers

"] Finandials
Functional Areas Fusion Accounting Hub

. Manufacturing and Supply Crain Malerials Management
Inital Users

Frojec: Financial Management

* Enterprise Profle = View v Formal v Freeze

Recruiting anc Candidate Experience Defach Wrzp  Show

Service

* Lagal Stuctures Tesk Scope
Workforce Deployment
* Organization Structures

Workforce Development

* Financial Reportng Structures

* Viorkfores Struchures srares (B2
* Users and Securiy srares 2

HCM Data Loader Eeey -

Workfores Information srares )
* Basic Payrol [ ~ ]
* Base Py [ -]
* Beneits e D)
* Individua Compensation srares B
Workforc2 Compensation [ ]
* Total Corensafon Stzements [ +]

Under Functional Areas, click Job Requisitions




Setup: Recruiting and Candidate Experience &

Functional Areas

* Initial Users

* Enterprise Profile

* Legal Structures

* Organization Structuras

* Financial Reporting Structures

* Workforce Structures
Workforce Profiles

* Users and Security

* Workforce Information
Benefts
HCM Data Exchange

* Recruiting and Candidate Experience Management

ob Requisitions

* Candidate Experience

Click Job Requisitions

" Candidate Job Applications

View C Search Tasks ‘ ‘ 0\|
sares BB Job Requisitions
Sharee (D View v Format v Detach Show | Required Tasks v
srares 6 Task
Job Requisition Templates
srares (X0
Job Requisition Descriptive Flexfields
srares (D Columns Hidden 3
snaree (D
srares (KD
srares (K
srzres (D
sraree (5D
=
=
=

Next, click Job Requisition Descriptive Flexfields

Functional Areas

* Initial Users

* Enterprise Profle

* Legal Structures

* Organization Structures

* Financial Reporting Structures

* Workforce Structures
Workforce Profies

™ Users and Security

™ Workdorce Information
Benefits
HCM Dala Exchange

* Recuting and Candidats Experience Management

* Job Requisitions

* Candidate Experience

* Candidate Job Appiications

sraree B
srares (8B
croree B
sraree B
srores B
sraree D)
snares ()
srares ()
sraree B
sraree B

Job Requisitions

[ Detach Wrap  Show

View v Format v

Task S

Job Requisiton Templates

Job Requisition Descriptive Flexiel

Columns Hidden 3

Click Job Requisition
Descriptive Flexfields

Next, click the Pencil icon

—




Job Requisition Descriptive Flexfields &

Search Results Click Pencil Icon

Actions w View v Format v Freeze [yl Detach Wrap

Module

Name Type

-Job Requisition Descripti.. Descriptive Flexfield  Job Requisitions Core

Flexfield Code

IRC_REQUISITIONS_DFF

Entity Usages.

Description

Additional fields for requis... L4

Deployment Error

Deployment
Status Deployment Date

$15/227.03 PM

Highlight the row for the items that needs edited and click the Pencil icon

Job Requisition Descriptive Flexfields @

Name Job Requisition Descriptive Flexfield

Flexfield Code IRC_REQUISITIONS_DFF

‘Additional fields for requisition

Click Pencil Icon

Description

Global Segments

Freeze i) Detach « Wrap

Actions v View v Formatw o n

* Sequess? Name

Columns Hidden 9

Table Column Value Set

ATTRIBUTE_CHAR1 DPT_LOV

Context Segment

* Prompt | Context Segment

API Name

Value Set ‘

Default Type

[] Required

* Display Type

Prompt

Departmert

l Manage Contexts “ Manage Segment Labels ‘ @l ‘Save and Close ‘@

Segment Separator

Application ~ Recruting

Module  Job Requisitions Core

[7] & Enabled

Bl Label

Definition Help Text

Instruction Help Text

Next, click View Value Set

—

]
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Edit Segment @

4
Flexfield Name  Job Requisiton Descriptie Flexfield
Code Department
Column Assignment
DataType Cherecler
Validation
Value Set Description Deparment Veluss
Initial Default
Default Type
Display Properties

Display Size \:|
Display Height E

Flexfeld Code IRC_REQU ST ONS_DFF

Description

V] Enstled

Table Column  ATTRIBUTE_CHAR !

Create Value Set

iew Value Set

Range Type

Click View Value Set

[[] Fequired

Definiton Help Text
4

Instructon Help Text
4

Next, click Manage Values

Edit Value Set: AGENCY_PR

Value S2tCode AGENCY FR

Description ‘
*ModuleHR Person Detals v
Validation Type  desendent
Vale Datz Tyde - Character
] Seeutty srabled
Data Security Resource Name Edit Data Security

Definition
Value Sudtype Test

* Maximum Langth

] Uneercase anly

[ zenti

Il Saveand Close | Cancel

Click Manage Values

Click Search

—
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Manage Values \EH ‘Save and Close

Value Set Code  AGENCY_PR

Description

4 Search

Description ‘

—

Search Resuits Click Search
Actons v View v Fomatv o @ Freezz [g) Detach | Wrap
*Value A Description Enabled StatDats  EndDate  Sor

No search conduced.
Columns Hidden *

Here we can add new values by clicking the +. To disable existing values, uncheck
Enabled checkbox. Once complete, click Save and Close

Manage Values @

Value Sel Code  AGENCY_PR

Click Save and Close

Desciiption
4 Search
Descrpton |
e
Search Results CEHBAN =2 Deselect the Values to Disable
Actions v View v Format v P @ Freeze [ Detash . Virap
*Value A Description Enabled | StartDate  EndDate  SortOrder

ACAA ‘ ACAA ‘ vl 1111851 midlyyyy E
i 11111951 iy E

ADU SERV BENERALES ‘ ADM SERV GENERALES

Columns Hidden 1

Create Content Library Item

Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and
Candidate Experience>Functional Areas>Recruiting and Candidate Experience
Management>Recruiting Content Library>Create>Save and Close

From the home screen, click My Enterprise

]

—



Good morning,

PROD IMPLADMIN!

QUICK ACTIONS

Click My Enterprise

Medical Plan Comparison

©

Time and
Absences

ﬁﬁ ¢
Career and
Performance

Sublic Info
Directory Journeys Personal
Information

Change Photo

®

Learning

My Benefits
Summary

kg

Company Benefits
Portal

el

Oppertunity
Marketplace

nal Info Conalis

Document Delivery Prefere

Eligible Jobs

(R

Current Jobs

2

il

Performance

4’,

Safety Incidents Camptra Support

Resignation Portal

Chain Planning My Enter

QUICK ACTIONS

Available

<J

New Faaturas

7
Do

Feature Updates

+

Offerings Setup and

Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Retroactive

Report

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Retroactive

Notification Report

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Payroll
Validation Report

=)

1 month ago

ACTION REQUIRED

Test 1043 Manu:
Approval For Uy

File >

|

Change setup to Recruiting and Candidate Experience




Click Dropdown
Functional Areas
* Intial Users
* Enterpriss Profile
* Legal Structures
* Organization Structures
* Fnancial Reportng Structures
* Workorcs Structures
* Users and Securty
HCM Data Loader
Workforcs Information
* Basic Payroll
* Base Pay
* Banefits
* Individual Compensation
Worklorcs Compensation

* Total Conpensalion Sta'ements

Setup: Compensation Managepss

Compensation Management

" Finandials
Fusion Accounting Hib

Manuacturing and Supply Crain Malerils Nanagement

Projec: Finandal Management
Recruling an Candidate Experience
Senicz
Workfurce Deployment

Workforce Development

Initial Users

View v Format v

Task

Freeze

Scope

Functional Areas

* Initial Users

* Enterprise Profile

* Legal Structures

* Organization Structures

* Financial Reporting Structures

* Workforce Structures
Warkforce Frofiles

” Users and Security

™ Worlforce Information
Benefts

HCM Data Exchange

" Recruiting and Candidate Experience Manages

* Job Requisitions
* Candidate Experience

* Candidate Job Applications

Click Recrui

View C

Search Tasks

crare: (B
snares (BB
snares BB
snares BB
srares (KB
srares D)
srares D)
sreres (D
gy ~ ]
snares (0

=

=

g and Candidate

Experience Management

Initial Users.

View v Format v

ze ] Detach
Task

Run User and Roles Synchronization Process

Columns Hidden 3

Show | Required Tasks v

Next, click Recruiting Content Library

—
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Functional Areas

* Iniial Users

" Enterpiise Prafile

" Legal Struclurss

" Organization Stractures

" Financial Reporting Struclures

" Workforce Struclures
Workirce Profes

™ Users and Secuity

™ Workforce Informarion
Benes
HOM Data Exchange

" Recritng anc Candidate Experiznce Management

" Joo Requistions

Cencidate Experience

Cancidate Jok Applicatiors

Vi Confguaticn | S¢1 Tosks :
arree D Recruiting and Candicate Experience Management

sras D View v Foma v

i’ Detach Wrap

sres 6D Task

Enterprise Recruling and Candidate Experience Informaion

sras D
Recrung ard Candidats Expeience Lookups
sraee 6B Recrting ard Candidatz Experience Value Sets
orres D Recruiting ard Candidate Experience Profie Option Veluzs
Corfigute Recnifng Interactior Categores
Eey ]
Recruiing Content Liorar
Srass
L Geogiaphy Herarcies
srres (B Geography Hierarchy Stucture
Recrutng Categary Provisioning and Confguration
s D o Fosones i s

Recruiting Category Enablerent

Celumns Hidden 3

Click Recruiting Content Library

Show

Scope

Next, click Create

< Recruiting Content Library

Candidate Confirmatiol
CCNK

Click Create

PA Employer Description
PA-EMP

Accounting Manager

ACCOUNTING_MANAGER

Accounting Manager
ACC_MNGR

ation

Cand_Auto_Dupe_Not
Cand_Auto_Dupe_Nofification

Change Candidate Email Co...

Change_Candidate_Email_Confirm

Change Candidate Email Ve...

Change_Candidate_Email_Req

Offer Letter Test - DO NO...
DNU

E-Signature
E001

Employer Description

Category  Automated Job Application Notification
Vi

ity Internal, External

Category  Employer Description

Visibility  Internal, External

Category Posting Description

Visibility  Internal, External

Category ~ Posting Description
vi

ity Internal, External

Category  Automated Duplicate Check Notification
vi

ity Internal, External

Category  Candidate Email Update Confirmation Notification
Visibility  External

Category  Candidate Email Update Request Notification
Visibility  External

Category Job Offer Letter Template
vi

ity Internal, External

Category Job Application E-Signature Statement
vi

ity Internal, External

Category _Employer Description

Versions

Start Date

Versions

Start Date

Versions

Start Date

Versions

Start Date

Versions

Start Date

Versions

Start Date

Versions

Start Date

Versions

Start Date

Versions

Start Date

Versions

21722

208122

3121

3721

471020

s

15719

63021

3/17/20

Next, enter the Name, Code, and Category




Create Content Item

Content Item Details

“Name \ Camptra Employer Description

*Code ‘ CT_EMP_DES

*Category \ Employer Description

Enter Name, Code, and Category

ity ‘ Internal, External

Messaging
Capture Message
Token NotificationBe v
Message
Content

Version Details &3

*Start Date | m/d/yy homma z [ig | (UTC+00:00) Coordinated Universal Time (UTC)

[ start on Activation

Enter the information in the Content section

Create Content Item

“Category | Employer Descrip

Vi

lity | Internal, External ‘

Messaging
Capture Message
Token ificationBe ~ nsert
Message
Content

Version Details &3

“Start Date | m/d/yy h:mm a z % | (UTC+00:00) Coordinated Universal Time (UTC)

—

“Content

We at Camptra Technologies started our Journey in 2016 as a team and 9 iali
Today, we use our combined expertise to provide solutions that are not only optimal for your business but also cost-effective and
people-oriented

Our team of top-notch have a

of 75 years in the Oracle solution space. As trusted implementation
partners for business, we believe that open communication with our clients is the key to developing relevant solutions. We focus
therefore, on working with you every step of the way to design selutions that are efficient, dynamic and scalable so that your
business always keeps pace with industry changes

Visit us at https://camptratech.com/

Lastly, click Save and Activate




Create Content Item [sempar[* [ cna |

Save and Actvate | 8

Save as Diaft

Content Item Details (3

Click Save and Activate

“Name ‘ Camptra Employer Description

*Code ‘ CT_EMP_DES

“Category ‘ Employer Description

“Visibility ‘ Intemal, External

Messaging
Capture Message
Token NotificationBody ¥ Insert
Message
Content

Version Details )

*Start Date | m/djyy hemm a 2 fig | (UTC+00:00) Coordinated Universal Time (UTC)

[ start on Actvation

“Content

= Kl

Managing Career Site

Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and
Candidate Experience>Functional Areas>Candidate Experience>Career Sites
Configuration

From the home screen, click My Enterprise

Good morning, PROD IMPLADMIN!

¢ Service Help Desk Supply Chain Planning My Enterprise Tools Configuration
QUICK ACTIONS APPS Click My Enterprise
edical Plan Comparison

8 (B li¥, 04

Directory s Time and Career and Personal
Absences Performance Information

ly Public Info

df; Change Photo

2t el I Learning Benefits My Benefits Company Benefits Opportunity
Sumnmary Portal Marketplace

[E] Document Delivery Prefarences

Eligible Jobs @ D’lﬁu +

Current Jobs Safety Incidents Performance Camptra Support
Resignation Portal

Show More

Click Setup and Maintenance




Good morning, PROD IMPLADMIN!

Service
QUICK ACTIONS

ailable Features
oo
Offerings New Features Festure Updates Setup and
Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago 2 weeks ago 2 weeks ago 1 month ago

ACTION REQUIRED. ACTION REQUIRED. ACTION REQUIRED. AcTIoN RequIRED.

EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 Test 1043 Manu:
Manual Task Approval | Manual Task Approval Approval For Ug
For Verify Retro For Verify Payroll File >
Report Validation Report

103

o)

Change setup to Recruiting and Candidate Experience

Setup: Compensation Managemsi? @

Compensation Menagement

Click Dropdown

e St [[a)

€ nitalUsers

"] Finandials
Functional Areas Fusion Accounting Hub

. Manufacturing and Supply Crain Malerials Management
Inital Users

Frojec: Financial Management

* Enterprise Profle = View v Formal v Freeze

Recruiting anc Candidate Experience Defach Wrzp  Show

Service

* Lagal Stuctures Tesk Scope
Workforce Deployment
* Organization Structures

Workforce Development

* Financial Reportng Structures

* Viorkfores Struchures srares (B2
* Users and Securiy srares 2

HCM Data Loader Eeey -

Workfores Information srares )
* Basic Payrol [ ~ ]
* Base Py [ -]
* Beneits e D)
* Individua Compensation srares B
Workforc2 Compensation [ ]
* Total Corensafon Stzements [ +]

Under Functional Areas, click Candidate Experience




Functional Areas

* Initial Users

* Enterprise Profile

~ Legal Structures

* Organization Structures

* Financial Reporting Structures

* Workforce Structures
Worklorce Profles

™ Users and Security

* workforce Information
Benefits
HCM Data Exchange

* Recruiting and Candidate Experience Management

* Job Requisitions

Candigate Experience

" Candidate Job Applications

Click Candidate Experience

View Configuration | Search Tasks |[2]

snaree (B Initial Users
srarec @ View w Format w
snares @) Task
Run User and Roles Synchronization Process
share: D
Columns Hidden 3
snares @)
srares (KD
shares @)
snares (KD
shares (KD
srares @)
=
=
=
=
=

Click Career Sites Configuration

Functional Areas

* Inital Users

™ Enterprise Profile

* Legal Structures.

* Organization Structures

* Financial Reporting Structures

™ Workforce Structures
Workiorce Profies

* Users and Security

™ Workforce Information
Benefits
HCM Data Exchange

™ Recuiting and Candidate Experience Management

* Job Requisitions

* Candidate Experience

* Candidate Job Applications

View Configuraion  S00r°h Tasks : ‘i‘

srares 62
sroree 6B
srores 62
srares 2
srore: 6B
srres @B
sraree (BB
srwres @2
srres B
srares 6B

Candidate Experience

View v Fomat v Wrap  Show

Task

Career Sites Configuration

Job Appication Flow Configuration

Double Opt In Management Click Career Sites Configuration
Configure Candidate Experience Map Provider

Columns Hidden 3

Locate the company’s website and click the Gear then Edit

Wrap  Show | Required Tasks v




Career Sites Configuration

CTC Career Openings Default Language: American Englsh o
ac
Prestera Center Demo Heble i AR Egheh &
PC_DemoSitz

i ,EQS,.,DemO Site kbl iass? Aen Can EhGish o

AUBURN Demo Site Default Language: American Engiish
AUBURN_CX et S E
Deactivate Click the Gear

site

GOF Demo Site

GOF.CX

Default Language: American English

Click Edit

In this screen, we can verify and update the Career Site details through the various
tabs. Once complete, click Publish Site

Publish site

Click Publish Site

Use these tabs to update the Career Site Active ('

GOF Demo Site

Site Code

GOF_Cx

J

IS0 MEPA10  MEPAMY  MEPA12  MEPA3  MEPA4  MEPAS  MEPAS  MEPA7  MEPAS  MEPAQ  Administrative  Clerical Brecutive  Management  Professional

Sr.Management  TESTADMIN  TESTADMIN.1 TESTADMIN2  TEST_JOB_FAMILY_CONV

J

PUSLVCISN  Administrative  Legal | Managerial

Recruiting Types

Job Application Flow

Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and
Candidate Experience>Functional Areas>Candidate Experience>Job Application
Flow Configuration

From the home screen, click My Enterprise

—

]
31|



Good morning,

PROD IMPLADMIN!

QUICK ACTIONS

Click My Enterprise

Medical Plan Comparison

©

Time and
Absences

ﬁﬁ ¢
Career and
Performance

Sublic Info
Directory Journeys Personal
Information

Change Photo

®

Learning

My Benefits
Summary

kg

Company Benefits
Portal

el

Oppertunity
Marketplace

nal Info Conalis

Document Delivery Prefere

Eligible Jobs

(R

Current Jobs

2

il

Performance

4’,

Safety Incidents Camptra Support

Resignation Portal

Chain Planning My Enter

QUICK ACTIONS

Available

<J

New Faaturas

7
Do

Feature Updates

+

Offerings Setup and

Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Retroactive

Report

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Retroactive

Notification Report

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Payroll
Validation Report

=)

1 month ago

ACTION REQUIRED

Test 1043 Manu:
Approval For Uy

File >

|

Change setup to Recruiting and Candidate Experience




Click Dropdown
Functional Areas
* Intial Users
* Enterpriss Profile
* Legal Structures
* Organization Structures
* Fnancial Reportng Structures
* Workorcs Structures
* Users and Securty
HCM Data Loader
Workforcs Information
* Basic Payroll
* Base Pay
* Banefits
* Individual Compensation
Worklorcs Compensation

* Total Conpensalion Sta'ements

mpensation Managems

Compensation Management
" Finandials
Fusion Accounting Hib

Manuacturing and Supply Crain Malerils Nanagement

Projec: Finandal Management
Recruling an Candidate Experience
Senicz
Workfurce Deployment

Workforce Development

Initial Users

View v Format v

Task

Freeze

Scope

Functional Areas

* Initial Users

* Enterprise Profile

* Legal Structures

* Organization Structures

* Financial Reporiing Structures

* Workforce Structures
Workforce Profiles

* Users and Security

* Workforce Information
Benefits

HCM Data Exchange

* Recruiting and Candidate Experience Management

* Job Requisitions

Candidate Experience

* Candigate Job Applications

Click Candidate Experience

View Configuration

Shared

Sharag

Shared

Shares

Shares

Sharee

Shares

Shared

Shares

Shared

»

‘.

Search Tasks

Initial Users

View v Format v Detach
Task
Run User and Roles Synchronization Process

Columns Hidden 3

Show | Required Tasks v

Click Job Application Flow Configuration




Setup: Recruiting and Candidate Experience &3

Functional Areas View Configuration | Se27Ch Tasks ‘ (2]
* Initial Users snares (EED Candidate Experience
* Enterprise Profile snarec (D View v Format w Freeze Wrap  Show | Requirad Tasks v
* Legal Structures srare: 5D Task
Career Sites Configuration
™ Organization Structures — . ]
Job Application Flow Configuration

Financial Reporting Structures shares (DD Double Opt In Management
" Workforce Structures shares @ Configure Candidate Experience Map Provider

Workorce Frofi . Columns Hidden 3

orkforce Profiles Shared o BT .
Click Job Application Flow Configuration

* Users and Sacurity snares (EED
* Workforce Infermation sharee (D

Benefits snares @RED

HCM Data Exchange =
* Recruiting and Candidate Experience Management =
* Job Requisitions =
" Candidate Experience =
" Candidate Job Applications =

«

Click Job Application Flow

{ Job Application Flows

Show it

+ Create

External Apply Flow Code Draft [ -]
ORA_GLOBAL EXTERNAL Application Flow Type  Apply

NK Application Flow Code Active =
ORAC_INTERN_FLOW Application Flow Type  Apply

External Candidate Application Flow Code Active [ -]
EXT001 Application Flow Type  Apply

Code Draft [ -]

Application Flow Type  Apply

Job Application Flow

JAF

Click Job Application Flow

PA external app Code Active =
PAEX Application Flow Type  Apply

NK - New Application Flow Code Active [ -]
NK_EEO_APP Application Flow Type Apply

NK-Request Information Code Active [ ]
NK-REQ-INFO Application Fow Type ~Request Information

Click on the current version; this is indicated but the green dot across from Version
Start Date




4 ggsic Information #/
*Application Flow Name  NK Application Flow
*Code ORAC_INTERN_FLOW

* Application Flow Type Apply
Description

4 Context Information #

Recruiting Type Professional

4 \ersions

‘ + Create ‘

Version Start Date6/20/2022 10:42 AM UTC . [ -]

Click Version Name Version Start Date1/20/2022 %:30 AM UTC i [ -]

Review the current version. If updates are required, click Actions, then Copy to
Create New Version then OK

Copy to Create New Version
e V2 Delete
te 6/2012022 1042 AM UTC

nStetus Curent

Click Copy to Create New Version

Legal Disclaimer £-Signature Campaign Opt In One Page Appiication Flow Job Alert Opt In

sersoral vy

Profile Import Centact Information

Address

Education

Education

Experierce

‘ Experience

Updates can now be entered. Enter the new Version Name and the other
applicable information. Once complete, click Save and Activate




NK Application Flow y—

o  Cick Save and Activate
o - .
| o ! | Enternthejupdated|information below,
Version Start Date | m/d/yyyy homm a z +00:00) Coordinated Universal Time (UTC) =

[ start on Activation

Version Status Draft .
Enter Version Name

¥/ Legal Disclaimer [¥] E-Signature (] Campaign OptIn I One Page Application Flow %! Job Alert Opt In

4 Personal Info #

Block Library
@
Profile Import Contact Information Address e LngEges
v - - - -
4 Education #
— Education Job Application
Questions
-
Education —
v
Licenses and Timeline
4 Experience & Certificates
v v
Experience
. Disability Diversity
— - -
4 More About You ¢ - JC -

Candidate Selection Process

Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and
Candidate Experience>Functional Areas>Candidate Job Applications>Candidate
Selection Process Configuration

From the home screen, click My Enterprise

Good morning, PROD IMPLADMIN!
Service Help Desk Supply Chain Planning
QUICK ACTIONS Click My Enterprise
& (@]
@& {12 ™

Diractory Journeys Time and Career and Personal
Absences Performance Information

35 Medical Plan Comparison
y Public Info

Change Photo

2t el I Learning Benefits My Benefits Company Benefits Opportunity
Sumnmary Portal Marketplace

Document Delivery Prefere

Eligible Jobs @ % D’lﬁu

Current Jobs Safety Incidents Performance Camptra Support
Resignation Portal

4’,

Show More

Click Setup and Maintenance




Good morning, PROD IMPLADMIN!

Service
QUICK ACTIONS

ailable Features
oo
Offerings New Features Festure Updates Setup and
Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago 2 weeks ago 2 weeks ago 1 month ago

ACTION REQUIRED. ACTION REQUIRED. ACTION REQUIRED. AcTIoN RequIRED.

EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 Test 1043 Manu:
Manual Task Approval | Manual Task Approval Approval For Ug
For Verify Retro For Verify Payroll File >
Report Validation Report
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o)

Change setup to Recruiting and Candidate Experience

Setup: Compensation Managemsi? @

Compensation Menagement

Click Dropdown

e St [[a)

€ nitalUsers

"] Finandials
Functional Areas Fusion Accounting Hub

. Manufacturing and Supply Crain Malerials Management
Inital Users

Frojec: Financial Management

* Enterprise Profle = View v Formal v Freeze

Recruiting anc Candidate Experience Defach Wrzp  Show

Service

* Lagal Stuctures Tesk Scope
Workforce Deployment
* Organization Structures

Workforce Development

* Financial Reportng Structures

* Viorkfores Struchures srares (B2
* Users and Securiy srares 2

HCM Data Loader Eeey -

Workfores Information srares )
* Basic Payrol [ ~ ]
* Base Py [ -]
* Beneits e D)
* Individua Compensation srares B
Workforc2 Compensation [ ]
* Total Corensafon Stzements [ +]

Under Functional Areas, click Candidate Job Applications




Setup: Recruiting and Candidate Experience &3

Search Tasks ‘ ‘ Ql

Functional Areas Change Feature OptIn
* Initial Users shares D Candidate Job Applications
* Enterprise Profile shares D View w Format w Detach Wrap  Show | Required Tasks v
* Legal Structures snares DD Task
Candidate Selection Process Configuration
* Organization Structures — - ]
Candidate Selection Process Reasons
Financial Reporfing Structures Shares Colmns Hidden 4
* Workforce Structures shares (B
Workforce Profiles srares (EID
* Users and Security shares (B
* Workferce Information shares (B
Benefits snaras (B
HCM Data Exchange =
* Recruiting and Candidate Experience Management =
~ Job Requisitions =
Click Candidate Job Applications
* Candidate Experience =
I Candidate Job Applications V =

Click Candidate Selection Process Configuration

Setup: Recruiting and Candidate Experience &

Functional Areas Change Feature Optin  S63rch Tasks ‘ ‘i‘
“ Initial Users - Candidate Job Applications
* Enterprise Profile sharec (D View v Format w Freeze Detach Show | Regquired Tasks v
* Legal Structures srarec D Task
Candidate Selection Process Configuration
* Organization Struetures sharec (D
Candidate Selection Process Reasons
Financial Reporting Structures sharec (RED Columns Hidden 4
* Workforce Structures snares (D) Click Candidate Selection Process Configuration
Workforce Profiles snares (RED
~ Users and Security sharec ERD
~ Workforce Information ey - |
Benefits snares @D
HCM Data Exchange =
~ Recruiting and Candidate Experience Management =
* Job Requisitions =
~ Candidate Experience =
~ Candidate Job Applications =

]

Click the Candidate Selection Process Name




{ Candidate Selection Process Configuration

4 search

N P \

Code [surwin | \

Search Results

4 Create D o Click Candidate Selection Process Name

Name & Code Status A Process Type Default Last Modifie
NK Candidate Selection Process © NKCP002 @ Active Standard Campus 6/2712022
NK Candidate Selection Process @ NK002 @ Active Standard Professional 6/27/2022
NK- Candidate Selection Process-Task @ NK-CSP-CON @ Active Standard 8/3/2022

PA Candidate Selection Process @ PACSP1 @ Active Standard 6/27/2022

In the candidate selection process screen, verify the Phases and the States for
Phase. Click on the links in each phase to view their details. To edit, click the Pencil
Icon

< NK Candidate Selection Process

b= SR it cip Ko e AR
Code NKCPOO2 Status  Active Process Type Standard

Phases
New @ Sereening Interview and Selection Offer HR
States: 5 States: 8 States: 8 States: 9 States: 7
5] 5]
- N Click Pencil Ilcon
Phase Details: New  #
Mandatory No
Visibility Unrestricted
Phase New
When Entering Phase = Calculate Computed Fields (Inactive)
When Leaving Phase =
States for Phase: New
Name Gandidate Status. Actions. Move Condition
To be Reviewed Under Consideration = =
Reviewed Under Consideration = =
Selected For Screening Under Gonsideration = =

Once the updates have been made, click Save and Close
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Edit Phase: New

Properties

Neme  New
Descripiion  New phase.

States

Create
" Name * Candidate Status
To be Reviewed Under Considera
Revewed Under Considera
Selected For Screening Under Considerafion

©  Wittdrawnby Cndidate Wi

©  Rejected by Employer Not Retained

Order

Click Save and Close

Saveand Close
—

Create Interview Templates

Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and
Candidate Experience>Functional Areas>Job Requisitions>Interview Schedule

Templates

From the home screen, click My Enterprise

Good morning, PROD IMPLADMIN!

< Service Help Desk Supply Chain Planning
QUICK ACTIONS APPS

edical Plan Comparison

58

ty Public Info
Directory

df; Change Photo

are Data Access @

are Personal Info Learning

[=] Document Delivery Preferences

Eligible Jobs @

Current Jobs

Resignation

Show More

Click Setup and Maintenance

My Enterprise Too

Benefits

Safety Incidents

Is Configuration

Click My Enterprise

©

Time and
Absences

My Benefits
Summary

il

Performance

li¥,

Career and
Performance

g

Company Benefits

Camptra Support
Portal

)

Personal
Information

7=

Opportunity
Marketplace

4’,
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Good morning, PROD IMPLADMIN!

Service
QUICK ACTIONS

ailable Features
oo
Offerings New Features Festure Updates Setup and
Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago 2 weeks ago 2 weeks ago 1 month ago

ACTION REQUIRED. ACTION REQUIRED. ACTION REQUIRED. AcTIoN RequIRED.

EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 Test 1043 Manu:
Manual Task Approval | Manual Task Approval Approval For Ug
For Verify Retro For Verify Payroll File >
Report Validation Report
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Change setup to Recruiting and Candidate Experience

Setup: Compensation Managemsi? @

Compensation Menagement

Click Dropdown

e St [[a)

€ nitalUsers

"] Finandials
Functional Areas Fusion Accounting Hub

. Manufacturing and Supply Crain Malerials Management
Inital Users

Frojec: Financial Management

* Enterprise Profle = View v Formal v Freeze

Recruiting anc Candidate Experience Defach Wrzp  Show

Service

* Lagal Stuctures Tesk Scope
Workforce Deployment
* Organization Structures

Workforce Development

* Financial Reportng Structures

* Viorkfores Struchures srares (B2
* Users and Securiy srares 2

HCM Data Loader Eeey -

Workfores Information srares )
* Basic Payrol [ ~ ]
* Base Py [ -]
* Beneits e D)
* Individua Compensation srares B
Workforc2 Compensation [ ]
* Total Corensafon Stzements [ +]

Under Functional Areas, click Job Requisitions




Search Tasks | ‘E‘

Functional Areas Change Feature Opt In
=TS swaes @ [ Job Requisitions
 Enterprise Profile shares (RED View w Format w Freeze Detach Wrap  Show | Required Tasks v
* Legal Structures = Task
Shared

N Job Requisition Templates

Organization Structures Shares )

Job Requisition Descriptive Flexfields

~ Financial Reporting Structures chares (D Columns Hidden 4
~ Workforce Structures shares (I

Workforce Profiles snares (I
* Users and Security snarec @R
* Workforce Information shares (IR

Benefits shares (R

HCM Data Exchange =
* Recruiting and Candidate Experience Management =
755 Requisition =
~ Candidate Experience Click Job Requisitions =
~ Candidate Job Applications =

4

Under task, click Interview Schedule Templates. As a note, if this task does not
appear, use Search Tasks

Functional Areas Change Feature Opt In | Search Tasks | Intenview Schedule templates | ‘E‘
* Initial Users srares D Job Requisitions
~ Enterprise Profile shared (RdD View w Format w Freeze Detach Show
* Legal Structures Shares (D Task
* Organization Structures s €D Job Requisition Templates
Jab Requisition Descriptive Flexfields

* Financial Reporting Structures snares (R

Warkforce Structures srares Columns Hidden 3

Workforce Profiles sharee (D Click Interview Schedule Templates
" Users and Security snares (R
* Workforce Information srares (R

Beneiits snarec (R

HCM Data Exchange =
* Recruiting and Candidate Experience Management =
* Job Requisitions =
* Candidate Experience =
* Candidate Job Applications =

“

Click Add




Interview Schedule Templates

i S A

Templates

‘Swrhbymleormde O] ShowFilters | Status Active X Draft X Click Add

Sort By | Template Title - Ato Z v J

Camptra Interview - Candidate Managed Active
CAN

Schedule Type

Candidate Managed

Interview Template Active
INTOO1

Schedule Type
Hiring Team Managed

Enter the information into the below sections and click Continue to move to the
next section. Once complete, click Save and Close

Create Interview Schedule Template

Save and Close

BV
Click Save and Close

@ Basic Informarion Enterthe information in,each;section
*Schedule Title Schedule Type
[ Admiristrative Interview Template J ) Candidate Managed
®) Hiring Team Managed
“Schedule Code
[arr ‘
Continue |
Click Continue
(2) Location Details
etting

) Candidate Info

Manage Questionnaires
Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and

Candidate Experience>Functional Areas>Candidate Job Applications>Question
Library>Create>Save and Close

From the home screen, click My Enterprise

]
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Good morning,

PROD IMPLADMIN!

QUICK ACTIONS

Click My Enterprise

Medical Plan Comparison

©

Time and
Absences

ﬁﬁ ¢
Career and
Performance

Sublic Info
Directory Journeys Personal
Information

Change Photo

®

Learning

My Benefits
Summary

kg

Company Benefits
Portal

el

Oppertunity
Marketplace

nal Info Conalis

Document Delivery Prefere

Eligible Jobs

(R

Current Jobs

2

il

Performance

4’,

Safety Incidents Camptra Support

Resignation Portal

Chain Planning My Enter

QUICK ACTIONS

Available

<J

New Faaturas

7
Do

Feature Updates

+

Offerings Setup and

Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Retroactive

Report

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Retroactive

Notification Report

2 weeks ago

ACTION REQUIRED

EWT Payroll 02_2021_1
Manual Task Approval
For Verify Payroll
Validation Report

=)

1 month ago

ACTION REQUIRED

Test 1043 Manu:
Approval For Uy

File >

|

Change setup to Recruiting and Candidate Experience




mpensation Managems

Compensation Management

Click Dropdown

" Finandials
Functional Areas Fusion Accounting Hub

. Manuacturing and Supply Crain Malerils Nanagement
Intial Users

Projec: Finandal Management

Enterprisz Profile Recruting anc Candidate Experience

* Legal Structures Service

Workfurce Deployment

* Organization Structures
Workforce Development

* Fnancial Reportng Structures
* Workorcs Structures
* Users and Securty

HCM Data Loader

Workforcs Information

* Basic Payroll [ -]

* Bse Py [ -]

* Banefits

* Inevidual Compensation s 6D
Worklorcs Compensation [~]

* Total Conpensalion Sta'ements [+ ]

Initial Users

View v Format v

Task

Freeze

Scope

Functional Areas

* Initial Users

* Enterprise Profile

* Legal Structures

” Organization Structures

” Financial Reporting Structures

" Worldorce Structures
‘Workforce Profiles

* Users and Security

* Workforce Information
Beneiils
HCM Data Exchange

” Recruiting and Candidate Experience Management

” Job Requisitions:

Change Feature Opt In

Shared

Shared

Sharad

Sharad

Shares

Sharad

Shared

Shared

Shared

Sharad

" Candidate Experience

Candidate Job Applications

Click Candidate Job Applications

»

“«

Search Tasks | interview schedule templates

Candidate Job Applications
View v Format v

Task

Candidate Selection Process Configuration

Candidate Selection Process Reasons

Columns Hidden 3

Under task, click Question Library. As a note, if this task does not appear, use
Search Tasks




Setup: Recruiting and Candidate Experience &3

Search Tasks | Question Library ‘ ‘ |

Functional Areas Change Feature Opt In
= Initial Users Sharea IR Candidate Job Applications
* Enterprise Profile chared (ERAD View w Format w Detach
* Legal Structures sharea D) Task
Candidate Selection Process Configuration
* Organization Structures — . ] <
. Questionnaire Lookups
Financial Reporting Structures —
Question Library,
~ Worldforce Structures snaree (2D
Questionnaire Templates Click Question Library
Workforce Profiles sharee (KD
CQuestionnaires
Users and Securty srares B Candidate Selection Process Reasons
Workforce Information shares @RI Job Appiication Gomputed Fields Configuration
Benefits haree DD Columns Hidden 3
HCM Data Exchange =
* Recruiting and Candidate Experience Management =
~ Jab Requisitions =
~ Candidate Experience =
* Candidate Job Applications =

Next, from the dropdown select Subscriber as Recruiting

< Questions

Folders @

ISubs(riher Performance 360

View ¥ | Leaming Evaluations

4 [Questiol | eaming Observation Checklist *Keywords |
» Appl

Performance 360
» Disq
» EW1

Personal Brand Survey

Team Brand Mesting SUrve

b NR!

b Test

Time and Labor Time Card

Volunteering Question Code Question Text

‘Workforce Health and Safety Incidents No data to display.
Columns Hidden 1

Click Create




<{ Questions ®

Folders ® Folder: Question Library
Viewv 4
) Question Library *Keywords |

A Searcn Resuls B

Question Code Questidl

. Folder
Click Create
No data to display.

Columns Hidden 1

Enter the Details and click Save and Close

Create Question @ @[ oo Gose |

Click Save and Close

Subscriber Recruiting Question Version Number 1

Details Enterithe Details below;

Quesion @

“Question Text

Image None s

Instructions

[ Display the question conditionally

Context

We're offline

Question Classification | Prescreening Question Adc Leave a message

Next, navigate back to the tasks and click Questionnaire Templates

]
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Setup: Recruiting and Candidate Experience &

Functional Areas Change Feature OptIn | $%arch Tasks | Question Library ‘ ‘ a ‘
* Initial Users shares R Candidate Job Applications
* Enterprise Profile shared (D View v Format w Freeze
* Legal Structures . ] Task
. Candidate Selection Process Configuration
Organization Structures Shares D
Questionnaire Lookups
* Financial Reporting Structures shared D
Question Library
* Workforce Structures Shared (D)
Questionnaire Templates.
Workforce Profiles snaree (B2
Questionnaires A . .
Click Questionnaire Templates
Users and Securty srares Candidate Selection Pracess Reasons
* Workforce Information shared (R Job Application Computed Fields Configuration
Benefits raree D Columns Hidden 3
HCM Data Exchange =
* Recruiting and Candidate Experience Management =
* Job Requisitions =
* Candidate Experience =
= Candidate Job Applications =

Next, from the dropdown select Subscriber as Recruiting

< Questionnaire Templates «

™" Subscriber | Performance 360 |

* Keywords | Learning Evaluations

Learning Observation Checklist

Performance 360

arch Resul personal Brand survey

View v Format v

Team Brand Meeting Survey’

Click Recruitin:
Name Time and Labor Time Card g

Mo data to display. | Volunteering

Workforce Health and Safety Incidents

Click Create




< Questionnaire Templates @

4 Search

** Keywords ‘

4 Search Results

View v Format w

Name

Click Create
No data to display.

Enter the Basic Information and click Next

Click Next
Create Questionnaire Template: Basic Information @ )

Lz kg £ I B = N 4 FENERTRET

[ Score Questionnaire Entersthe Basic /Information usmus

*Name | Experience Level
InUse No

Description

4 |nstructions and Help Materials @

[J Allow changes to instructions

Attachments None =

Enter the Contents Information. Here we can add questions to the Questionnaire
template. Click Next




Create Questionnaire Template: Contents @

Click Next

Questionnaire Template ID300000037475311

Score Questionnaire

Section Order | Sequential v
Section ion | Stack Regions v

[J Allow changes to format options

[J Allow changes to sections
Allowed Response Types | All v
Sections @

View v Formatv < Create ¢ Edit X Delete

Allow
Tite Additional Description
Questions
1 O
2 v

1: Questions @
% Create = Add
Question Type

Question Code  Folder Response Type

Click Save and Close

Create Questionnaire

Basic Information

Questionnaire Template ID300000037475311
Scere Questionnaire
Name Experience Level
Owner Jack Recruiter

Description

41nstructions and Help Materials

Introduction
Attachments None
Contents

Section Order Sequential
Section Presentation Stack Regions

Sections

View v Format v

Allow
Title Addition: Description
Question
P 1 No

Entersthe

Question Text

Contents

00

Contents

75

= =

Response Order  Sample Size

Click Save and Close

Sayeand Close | ¥

Subscriber Recruiting
Status Draft

InUse No
Privacy Public

Question Respor
Crder Order
Vertical Vertical

Next, navigate back to the tasks and click Questionnaire

—
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Functional Areas
* Initial Users
* Enterprise Profile
* Legal Structures
* Organization Structures
* Financial Reporting Structures
* workforce Structures
Workiorce Profiles
* Users and Security
™ Workforce Information
Beneiis
HCM Data Exchange
* Recruiting and Candidate Experience Management
* Job Requisitions
* Candidate Experience

* Gandidate Job Applications

Change Feature Opt In

snares @
snares @
shared @R
shared @D
shared @D
snares B
snares D
snares D
Eey ~
shares @R

Search Tasks | questionnaire templates

Candidate Job Applications

View v Format v F

Wrap  Show | All Tasks

Task

Candidate Selection Process Configuration
Questionnaire Lookups

Question Library

Questionnaire Templates

Questionnaires

Candidate Selection Process Reason

Click Questionnaires

Job Application Computed Fields Config

Columns Hidden 3

Next, from the dropdown select Subscriber as Recruiting

{ Questionnaires

Folders @

Subscriber | Performance 360 | 4

View ¥ Learning Evaluations

Folder: Questionnaire Libr

4 [Questiol | earning Observation Checklist

¥ BT pertormancs 360

NR!
’ Personal Brand Survey

Team Brand Meeting Survey

P test

Time and Labor Time Card

Volunteering Dde .

Workforce Health and Safety Incidents 30000001253....
30000001253
PERF_GOAL
30000001506..

Columns Hidden 1

Click Recruiting

Create [E Copy # Edit

Questionnaire Name
Employee

Manager

Performance Goal Feedback

Test Questionnaire Campira Tech

 Preview

Click Create. Enter the Questionnaire Template Name and click Search

—

]
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Create Questionnaire

4 Search and Select: Questionnaire Template

Questionnaire Template ID ‘

Click Create Enter Name

View w Format v

‘Questionnaire
Template ID

300000011262853 Feedback Questionnaire

Select the Questionnaire Name and click OK

Create Questionnaire

4 Search and Select: Questionnaire Template

Click Search

Name Description Score Questionnaire

No

Questionnaire Template ID |

Name | Fesdback

4 Search Results
View v Format w

Questionnaire

Template ID Name Description

300000011268@83. Feedback Questionnaire

Highlight the Row of the
Questionnaire Name

Enter the Basic Information and click Next

Score Questionnaire

No

Click OK




Informatior

Create Questionnaire: Basic Information )

Click Next

*Questionnaire Code En’[er t_h_g Basm |nformatlon Subscriber Re

A WAL
Score Questionnaire

N Specify the folder the questionnaire is. Questionnaire Version Number 1
Name | Test stored in nUse o

*Folder k}uesﬂonnails Library v *Privacy

Owner | Jack Recruiter v

Description

ns and Help Materials @

Attachments None

Enter the Contents Information and click Next

Create Questionnaire: Contents @

. Click Next
Questionnaire Code 300000037475326

Score Questionnaire Enterthe.Contents
Section Order  Sequential et et bt tasirtesesc
Section Presentation Stack Regions

Sections @
View w Formatw 4 Create ¥ Delete
Allow
Title Additional Description g?:::w“
Questions £
1 No Vertical
2 Yes Vertical
1: Questions @
+ Create 4 Add / Edit 3 Delete
. . . Response Response
Question Code Question Text Folder Question Type  [°3F Orape
»  30000001121... How were the responses provided by the candidates (accuracy, fundamentals, etc) Recruiting Lib... - Single Choice Vertical

) 30000001121... Overall Performance (communication, skills, exposure, etc) Recruiting Lib... - Single Choice Vertical

Click Save and Close




Create Questionnaire: Review

e Click Save and Close
Basic Informaticn

Questionnaire Code 300000037475326 Subscriber Recruiting
Status Draft
Questionnaire Version Number 1
InUse No
Privacy Public

Description

4 nstructions and Helo Materials
Introduction

Attachments None

Contents
Section Order Sequential
Section Presentation Stack Regions
Sections

View v Format v

Allow
Title Addition: Description g'r‘:::"’“ sample Size gis"“"s' Required
Question
> 1 No Vertical Vertical  No
> 2 Yes Vertical Vertical  No

‘We're offline
Leave a message

Managing Primary Locations/Geography Structures

Navigation: Home>My Enterprise>Setup and Maintenance>Recruiting and
Candidate Experience>Functional Areas>Recruiting and Candidate Experience
Management>Geography Hierarchies>Actions>Update

From the home screen, click My Enterprise

Good morning, PROD IMPLADMIN!

¢ Service Help Desk Supply Chain Planning My Enterprise Configuration Others
QUICK ACTIONS APPS Click My Enterprise
35 Medical Plan Comparison

8 (B li¥, 04

Diractory Journeys Time and Career and Personal
Absences Performance Information

My Public Info

, Change Photo

Shats Per=ond Info Learning Benefits My Benefits Company Benefits Opportunity
Summary Portal Marketplace

Document Delivery Preferences

Eligible Jobs @ % Eﬁﬂ +

Current Jobs Safety Incidents Performance Camptra Support
Resignation Portal

Show More

Click Setup and Maintenance




Good morning, PROD IMPLADMIN!

Service Help Desk My Entel
QUICK ACTIONS

Available Features
g]ﬂ oo
Offerings New Features Festure Updates Setup and
Maintenance

Click Setup and Maintenance
Things to Finish

2 weeks ago 2 weeks ago 2 weeks ago 1 month ago
ACTION REQUIRED. ACTION REQUIRED. ACTION REQUIRED. AcTIoN RequIRED.
EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 EWT Payroll 02_2021_1 Test 1043 Manu:
241 Manual Task Approval Manual Task Approval Manual Task Approval Approval For Ug
For Verify Retroactive For Verify Retroactive For Verify Payroll File >
Report Notification Report Validation Report
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Change setup to Recruiting and Candidate Experience

Setup: Compensation Managemsi? @

Compensation Menagement

Click Dropdown

e St [[a)

€ nitalUsers

"] Finandials

Functional Areas Fusion Accounting Hub

. Manufacturing and Supply Crain Malerials Management
Inital Users

Frojec: Financial Management

* Enterprise Profle Recruling anc Candidate Experience = View v Format v Freeze etach Wrap  Show

Service

* Legal Structures Task Scope

Workforce Deployment
* Organization Structures

Workforce Development

* Financial Reportng Structures

* Viorkfores Struchures srares (B2
* Users and Securiy srares 2

HCM Data Loader Eeey -

Workfores Information srares )
* Basic Payrol [ ~ ]
* Base Py [ -]
* Beneits e D)
* Individua Compensation srares B

Workforc2 Compensation [ ]
* Total Corensafon Stzements [ +]

Under Functional Areas, click Recruiting and Candidate Experience Management




Setup: Recruiting and Candidate Experience &

Search Tasks ‘ ‘E‘

Functional Areas ‘Change Feature Opt In
* Initial Users — - = gand
~ Enterprise Profile shared (RAD View w Format w Wrap  Show | Required Tas
~ Legal Structures sharec R Task
. Enterprise Recruiting and Candidate Experience Information
Organization Structures Shares D)
Recruiting and Candidate Experience Lookups
* Financial Reporting Structures Sharea (D
Recruiting and Candidate Experience Value Sets
* Workforce Structures sharea (D
Recruiting and Candidate Experience Profile Option Values
Workforce Profiles Shared (D
Configure Recrutting Interaction Categories
Users and Security srarec @D Recruiting Content Library
* Workforce Information sharec (R Geography Hierarchies
Benefits p— - ] Geography Hierarchy Structure
HCM Data Exchange = Recruiting Category Provisioning and Configuration
* Recrutting and Candidats Experience Managemant = Recruiting Category Enablement
Columns Hidden 3
* Job Requisitions =
- Click Recruiting and Candidate
Candidate Experience . =
Experience Management
~ Candidate Job Applications =

“

Click Geography Hierarchies

Functional Areas Change Feature Opt In | S€arch Tasks ‘ | a |
* Initial Users srares B gand
* Enterprise Profile snarec (DD View w Format w Freeze show | Required Tasks v
” Legal Structures crares D Task
. Enterprise Recruiting and Candidate Experience Information
Organization Structures shares ()
Recruiting and Candidate Experience Lookups
* Financial Reperiing Structures — . ]
Recruiting and Candidate Experience Value Sets
" Workforce Structures shares (KD
Recruiting and Candidate Experience Profile Option Values
Workforce Profiles srarea (DD
Configure Recruiting Interaction Categories
Users and Security srarcs (D Recruiting Content Library
* Workforce Information shared (KD Geography Hierarchies
Benefits sharse D Geography Hierarchy Struclure ) ) )
Click Geography Hierarchies
HCM Data Exchange = Recruiting Category Provisioning and Configuraie
* Recmuiting and Candidate Experience Management = Recruiting Category Enablement
Columns Hidden 3
* Job Requisitions =
" Candidate Experience =
* Candidate Job Applications =

]

From the Actions dropdown, select Duplicate




¢ United States V5

4 Details
Name United States V5
Start Date 3/25/22 £:56 AM (UTC+0000) Coordinated Universal Time (UTC)

Status Cument

Duglcate

1" Uncate Geogrephy Names

Click Duplicate

4 Search
Tws‘ Starts with = ‘ ‘
Nam‘ Starts with v ‘ ‘
Ccﬂe‘ Starts with v ‘ ‘

e

Search Results

View v

Name A Code Type
» Austria AT county
» France R Couniry
» United Statzs us Country

First, check the checkbox Start on Activation. Under Geography Hierarchy, click +
to add a new location. Click x to remove an existing location. Once complete, from
the Save as Draft dropdown, click Save and Activate

Create Geography Hierarchy TR

L Save and Acivate

4Details g e |
*Neme | United States V' - 8/18/22 8:0

8/18/22 8:00 PM te

Qagt on Activation

Click Save and Activate

Start Cate (UTC+00:00) Ceordinated Universal Time (UTC)

Status Draft

Check Check box
Geograohy Hierarchy
m S Add Sublevels

View v

Name AT Code Trpe

Click + to Add New Locations o
! At Click x to Remove Exisiting Locations AT Country
» France R Country 2
b United States s Counry [ -]

Day-To-Day Work Area Navigation

To manage activities related to Day-to-Day Administration, from the home screen,
click My Client Groups

—

]
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Good afternoon, Michael Burke!

Help D
QUICK ACTIONS Click My Client Groups

Hire an Employ
O *

[id]

Journeys New Person Person Absences
Management

Add a Contingent Worker
" Add a Pending Worker

(@] el

il )

Pendi A Goals Performance Telent Review Succession Plans

Employment Contracts @ @ Sg @ <)::|:>

Talent Pools Workforce Mass Updates Workforce Data Exchange

ange Location Structures Modeling

Change Working Hours

+

QUICK ACTIONS

Hire an Emplor
) 74
Journeys New Person Person
Management

Add a Contingent Worker

Add a Pending Worker

Click Hiring

Add a Nonworker ey Q. Q.
ool i3

Pendin Vi . Performance Talent Review Succession Plans

Person

Employment Contracts @ @ (% § 5:?

Talent Pools Workforce Mass Updates Workforce Data Exchange

nge Location Structures Modeling

Promote

In this screen, we can manage Requisitions, manage Candidates, manage
Campaigns, manage Candidate Pools, manage Job Offers, and review Recruiting
Analytics




Recruit to Hire

Overview  Campaign & Source Tracking  Requisitions  Applcations  Selection & Offer ~ Hires

@ Recruit to Hire

[E sob Requisitions
Candidate Search

< campaigns

{3 candidate Pools

Job Offers

Year

2022 v

Quarter

(Al Column Valuesw.

Month

(A1l Colunn Valuesy.

Business Uit

US INS Business Uy

Legal Employer

Select Value- y.

Location

(Al Colunn Valuesy.

Department

-Select Value- v

Grade

SelectValue- y.

Job Family

-SelectValue-- v

Job

(Al Column Valuesw.

Recruitment Summary N 1ﬁ

Avg Regs # Applicants Acceptance % Total Hires Compa-Ratio

15.182 361 50% 8 13%

Recruitment & Openings
Top Job Families Based on Openings Recruitment Pipeline

Show View Graph v Show View Funnel v

Candidate Selection Process Name Campus and Hourly Candidate Selection Frocess v

s0.000%
8550%
20.240%

50.000%

View Open Requisitions

Navigation: My Client Groups>Hiring>View Open Requisitions

From the home screen, click My Client Groups

Good afternoon, Michael Burke!

My Team My Client Groups 3e s Admini: s Service

Help Desk My Enterp

QUICK ACTIONS.

Hire an Employee

Pending Workers

Person

Employment Contr:

1ange Location

\ange Working Hours

Click Hiring

Click My Client Groups

O *

]

Journeys New Person Person
Management

ol e

il &3

Performance Talent Review Succession Plans

4 i 23 =

Talent Pools Workforce Mass Updates Workforce Data Exchange
Structuras Modeling

+

>




Good afternoon, Michael Burke!

Me My Team My Client Groups io S E B < e Help Desk My Enterp

QUICK ACTIONS

Hire an Employee

O *

New Persan Person
Management

Add a Pending Worker
Click Hiring

Add a Nonworker = o0
el =)

Pend e Performance Telent Review Succession Plans

Employment Contracts @ @é (% @ <:::|>

Talent Pools Workforce Mass Updates Workforce Data Exchange
Change Location Structures Modeling

Change Working Hours

Promote

In this screen, we can view the Open Requisitions. We can filter the requisitions by
using the filter. Click Show Filters to use the filters to sort the Requisitions

le
Requisitions View/The @pen Requisitions Below, + A
Job Requisitions > L A e’
N Keywords 0“ Show Filters iring Team Rele  Recruiter, Hiring Marager, Collaborator X
\ Candidate Search
Sort By | Creation Date - New to Olc v
< Campaigns Solution Specialists PA (65) Applications: 0
Open - Posted Prospects: 0
(%) candidate Pools Standard
Bellevue, CC, United S:ates
T Job Offers PA testl (6) Applications: 0
Open - Posted Prospects: 0
Standard
United States
Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard
CA, United States
Network Specialist-NK (57) Applications: 3
Open - Posted Prospects: 0
Standard
CA. United States
PA HRIS Manager (54) Applications: 0
Open - Posted Prospects: 0
Standard
Bellevus, OC, United Siates
Were offine
Towing Team Crew Member (52) Applications: 2 Leave a message
Open - Posted Prospects: 0

Create A Requisition Using A Template
Navigation: My Client Groups>Hiring>Add>Submit

From the home screen, click My Client Groups

]
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Good afternoon, Michael Burke!

roups

Click My Client Groups

QUICK ACTIONS.
Hire an Empl
ontingent Worker
Add a Pending

Pending Wi Goals

ent Contras

Talent Pools
Location
Change Working Hours

+

Promote

Click Hiring

Joumeys

&l

Performance

&8y

Workforce
Structures

Good afternoon, Michael Burke!

/ Team My Client Groups

QUICK ACTIONS.
Hire an Emplos
Add a Contingent Worker
Add a Pending Worl
Add a Nonworker

Pending Workers

Talent Pools

Change Location
ange Working Hours

4‘,

Promot

Click Add

Journeys

Click
il

Performance

4

Workforce
Structures
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Job Requisitions

e

Requisitions
Job Requisitions

o Click Add
Keywords Q| showFilters  Hiring Team Role  Recruiter, Hiring Manager, Collaborator X

Q Cancidate Search

Sort By | Creation Date - New to Olc v

<l Campaigns Solution Specialists PA (65) Applications: 0

Open - Posted Prospects: 0
) candidate Pools Standard

Bellevue, DC, United States
% Job Offers PA_test1 (64) Applications: 0

Open - Pasted Prospects: 0

Standard

United States

Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

Network Specialist-NK (57) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

PA HRIS Manager (54) Applications: 0
Open - Posted Prospects: 0

In the How section, select the Requisition Type; Standard will default. Under Use,
select Template. Next, enter the Recruiting Type, Primary Location, and using the
assistive search, enter the Requisition Template; this is the Template Name. Once
the information is entered, click Continue

Create Job Requisition

How ]

@ Enter:the below/information
Requisition Type *Primary Location
Standard v | United States v|
“Use *Requistion Template
Template v ‘Nem\mk Specialist-NK (NetwrkSpec-NK) v ‘
“Rearuiting Type
Professional

Continue
Click Continue

) Requisition Structure

Next, in the Basic Info section, enter the Requisition Title, the Number of
Openings, if greater than 1, the Business Justification, and the Languages, if
applicable. Click Continue

—

]
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Create Job Requisition

() How

Save and Close Submit

‘ / Edit ‘

@ BasicInfo

Entersthe below/information

Requisition Type
Standard

*Requisition Title

Business Justification

[ etecta value v

‘ Languages

“Number of Openings

[ American Engiish

| Limited

1

(3) Hiring Team

4) Requisition Structure

Continue
Click Continue

Next, in the Hiring Team section, update the information below, if needed, and

click Continue

Create Job Requisition

(M How

(@) Basic Info

/ Edit

/ Edit

@ Hiring Team

Enterthe below/information

*Hiring Manager

*Recruiter

| Michael Burke Manager

= ‘ [Jack Recruter Analyst v

Add Collaborator Type

Collaborator

| tack Davies Consultant

v [x

Add Another Collaborator

Continue
Click Continue

(#) Requisition Structure [ s |

Next, in the Requisition Structure section, update the information below, if
needed, and click Continue

]
63 |
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Create Job Requisition

(3 How /' Edit

(2) Basic Info / Eit

(3) Hiring Team 7w

o Requisition Structure

Enterthe below/information

Recrutting Type Other Locations

Preisieisl [selecta value v
*Organization

Camptra Org

Primary Location
United States

Continue
Click Continue

Next, in the Details section, this information is present due to the use of a
template. Update the information below, if needed, and click Continue

Create Job Requisition

I . 5 PN e R
© Details Enternthe below/information
Full Time or Part Time Job Shift
Full time -] [Day v

gl \ 20000

Pay Frequency

Annually -] [ 90,000

Budget Currency Travel Budget

US Dollar -] [ 1500

Employee Referral Bonus Relocation Budget
o] \ 0

Sourcing Budget

*Department

HR - Recruitment v

Click Continue Continue

Next, in the Posting Description section, update the information below, if needed.
To update, click Enter Custom Internal Positing Description to make this section
editable and enter the applicable updates. Once complete, click Continue

]
64 |
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Create Job Requisition Save and Close

@ Posting Description

Posting Description for Internal Candidates

Network Specialist_NK

Short Description for Internal Candidates

Click Check box

Updatejthejbelowjinformation

Description for Internal Candidates

&

Network Specialist

Take your next career step at Camptra Tech with a global team that is energizing the transformation of society and industry to achieve a more productive,
sustainable future. At Camptra Tech, we have the clear goal of driving diversity and inclusion across all dimensions: gender, LGBTQ+, abilities, ethnicity
and generations. Together, we are embarking on a journey where each and every one of us, individually and collectively, welcomes and celebrates
individual differences.

Camptra Tech is a leading global technology company that energizes the transformation of society and industry to achieve a more productive, sustainable future. With
a history of excellence stretching back more than 130 years, Camptra Tech has been a pioneer through the four Industrial revolutions and is at the forefront of the
industry 4.0. By delivering digitalization to its electrification, roboltics, automation and motion portfolio, Camptra Tech pushes the boundaries of technology to drive:
performance to new levels. This is a Networking Specialist role, reporting to the Technical Manager in business area Process Automation located in Bangalore. You will
be working at Ability Innovation Centre (AIC), home to the largest technology and engineering pool in Camptra Tech globally and is a part of Camptra Tech Global
Industries and Services Private Limited, a subsidiary of Camptra Tech. It s based in Bangalore, the silicon-valley of India. lts unique infrastructure places research
development, engineering, and service teams under one roof, increasing collaboration and reducing time to market, with no compromise on qualty. If you are looking
for an environment that actively blends the boundaries between technology. data, domain and Industrial Al to create next generation analytics solutions for processes

Next, in the Skills section, click Add and enter the information. Click Save then,
Continue

Create Job Requisitio

(¥ Requisition Structure [ £ |
(5) Details e
(8) Posting Description [ £ 5|

0 < Enter:the below/information

Jab Coding Sklis

Suggested Skils Required
= s Select v ick Save
“skill Importance
| Medium v

Next, in the Offer Info section, update the information, if applicable. Click
Continue




Create Job Requisition

WY VIR N AN FEVIE TR, & )
(&) Posting Description [/ |
@ Skills | 7 e |
0 offer nfo Update)the below/information, ifapplicable

Legal Employer Primary Work Location

| RPebutorUsa nc ‘| | comprate ‘|

Other Work Locations
Business Unit

. . ‘Seledavalue v ‘
‘(amptra US Business Unit v ‘
Department
Job
‘HR-Reuuitmen: v ‘
‘Selsdavalus v ‘

Click Continue Continue

Next, in the Attachments section, upload an attachment, if applicable and click
Continue

Create Job Requisition

"S(.)Y S

-

(8) Posting Description [ /e |
(@) Skills [ /et |
Offer Info [ 7

@ Attachments

/2

Drag files here or click o add attachment v

Click Continue Continue

Next, in the Configuration section, update the Candidate Selection Process,
External Application Flow, Allow Candidates to Apply When Not Posted, and
Automatically Fill Requisition. Click Continue

—
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Create Job Requisition

(®) Posting Description

@ Sskills
Offer Info

(® Attachments

Save and Close Submit

‘ 7 Edit
7 Edit \
‘ 7 Edit

7 Edit \

@ Configuration Update the below/information, ifiapplicable
Update)the OLLE] s
“Candidate Selection Process Allow Candidates to Apply When Not Posted
NK Candidate Selection Process - NKCP002 v ‘ ‘ Yes v
“External Application Flow Automatically Fill Requisition
NK Application Flow - ORAC_INTERN_FLOW v ‘ ‘ Yes v ‘

Continue

Click Continue

D 0O
) Que

Lastly, in the Questionnaires section, add an Internal or External prescreening
guestion, if applicable. We can also attach an Interview Questionnaire.

Create Job Requisition

3 CEVERETRY. &
(1" How will you rate your communication skills?

Question Code Question Classification
3000001213057 Prescreening Question Added Automatically
Question Type ¥ Requires Response
Single Choice

1 How will you rate your technical skills?
Question Code Question Classification
3000001213053 Prescreening Question Added Automatically
Question Type ¥ Requires Response
Single Choice

21 How many years of experience do you have in this field?
Question Code Question Classification
3000001213043 Prescreening Question Added Automatically
Question Type ¥ Requires Response
Single Choice

Which of the following languages have you worked with for more than a year?

Question Code Question Classification
AQNK Prescreening Question Added by User
Question Type

VI Requires Response

Multiple Choice

Click Dropdown to Add Questionnaire

Interview Questionnaires

Add Questionnaire

[selecta value v

Maximum Pgssible Score 10

Click Submit




Create Job Requisitio:

NN

(® How

(@) Basic Info

(8) Hiring Team

(®) Requistion Structure

(3 Details

@ Postirg Descriotion

@ S«lis

(® Offer Info

Save and Close ! Submi
Click Submit

S Edit

/it

BRISRLE

/it

/ kit

BRLE

S Edit

/it

i |

/it

S Edit

i

Create A Requisition Using A Job/Position

Navigation: My Client Groups>Hiring>Add>Submit

From the home screen, click My Client Groups

Good afternoon, Michael Burke!

My Team My Client Groups Benefits Administration Sales

QUICK ACTIONS Click My Client Groups

& Hire an Employee
) O *

[ixd]

® Add a Contingent Worker
Journeys New Person

Add a Pending Worker

Add a Nonworker J[l
o
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Change Working Hours
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Good afternoon, Michael Burke!

Me

My Team

QUICK ACTIONS

Hire an Employ

Add a Contingent Worker

Add a Pending Werker

Add a Nenworker

Pending Warkers

Employment Contracts

Change Location

Change Working Hours

Click Add

Job Requisitions

Talent Pools

+

Journeys

O *

New Person

Click Hiring

il
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&

Workforce
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Workforce
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@an Requisitions

{ Candidate

Search

5 H Campaigns

D candidate Pools

=

-_1 Job Offers

Requisitions

Keywords

Solution Specialists PA (65)
Open - Posted

Standard

Bellevue, DC, United States

PA_test1 (64)
Open - Posted
Standard
United States.

Network Specialist-NK (60)
Open - Posted

Standard

CA, United States

Network Specialist-NK (57)
Open - Posted

Standard

CA, United States

PA HRIS Manager (54)
OEer - Posted

Q

\ Show Filters

Hiring Team Role ~ Recruiter, Hiring Manager, Collaborator %

Applications: 0
Prospects: 0

Applications: 0
Prospects: 0

Applications: 3
Prospects: 0

Applications: 3
Prospects: 0

Applications: 0
Prospects: 0

Click Add

Sort By | Creation Date - New to Olc v

In the How section, select the Requisition Type; Standard will default. Under Use,
select Job or Position. Next, update the Business Unit, if applicable and using the
assistive search, enter the Job. Once the information is entered, click Continue

—
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Create Job Requisition

‘ Saveand Close ‘ Submit ‘ Cancel

terthe below/information

Q How i
Recisition Type
‘ Standard v ‘
“Use
‘Jnh v ‘

Business Unit

‘ Camptra US Business Unit

*Job

‘ Clerk

(2) Basic Info

(8) Hiring Team

(4) Requisition Structure

Continge
Click Continue

Next, in the Basic Info section, enter the Requisition Title, the Number of
Openings, if greater than 1, the Business Justification, and the Languages, if

applicable. Click Continue

Create Job Requisition

(V) How

Save and Close Submit

‘ 4 Edit ‘

*Requisition Title

0 sasic nfo Entefthe below/information
Requisition Type Business Justification
Standard

[ etecta value

‘ Languages

“Number of Openings

| American English

| Limited v ‘ ‘

1

(4) Requisition Structure

Contine
Click Continue

Next, in the Hiring Team section, update or enter the information below, if needed,

and click Continue

—
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Create Job Requisition

@ How @

(2) Basic Info / it

@ Hiing Team Enterthe belowjinformation

*Hiring Manager *Recruiter

| Michael Burke Manager V] [Jack Recruiter Analyst &

Add Collaborator Type

Collaborator

| tack Davies Consutant v]x

Add Another Collaborator

Continue
Click Continue

(4) Requisition Structure [ 2 et ]

Next, in the Requisition Structure section, enter the information below, and click
Continue

Create Job Requisition

() How
(2) Basic Info
(3) Hiring Team

© Requisiion Structure Ententhe belowjinformation
Recruiting Type Other Locations
Professional ‘ Select a value b
*Organization Another Location

Camptra Org

Primary Location

United States

Continue
Click Continue

Next, in the Details section, enter the information below and click Continue

]
|
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Create Job Requisition sovoand Glose | [ submie |

R toir S X
@ Details f ;
Entersthe below/information
Full Time or Part Time Job Shift
Full time -] [ay v
Worker Type Job Type
Regular or Temporary Education Level
Regular -] [ Post-first rofessional v

Management Level

Senior manager -]
Compensation Currency Maximum Salary

Us Dollar | ( 120,000
Pay Frequency Minimum Salary

Annually -] [ 90,000
Budget Currency Travel Budget

US Dollar -] [ 1500
Employee Referral Bonus Relocation Budget

1000 | ( 500

Sourcing Budget

“Department

HR - Recruitment v

Next, in the Posting Description section, enter the Posting Description for Internal
Candidates; this is the job name. To update the posting description, click Enter
Custom Internal Positing Description to make this section editable and enter the
applicable updates. Once complete, click Continue

Create Job Requisition

[saveandciose | [ submit |

PN R 5 o B o & _—

(® Details 7 Ear

@ Posting Description

Posting Description for Internal Candidates

Network Specialist NK

nter Custom Internal Posting Description

Short Description for Internal Candidates

Click Check box

\WUpdate)thebelow/information

Description for Internal Candidates Ussss st

®

Network Specialist

Take your next career step at Camptra Tech with a global team that is energizing the transformation of society and industry to achieve a more productive,
sustainable future. At Camptra Tech, we have the clear goal of driving diversity and inclusion across all dimensions: gender, LGBTQ+, abilities, ethnicity
and generations. Together, we are embarking on a journey where each and every one of us, individually and collectively, welcomes and celebrates
individual differences.

Camptra Tech is a leading global technology company that energizes the transformation of society and industry to achieve a more productive, sustainable future. With
a history of excellence stretching back more than 130 years, Camptra Tech has been a pioneer through the four Industrial revolutions and is at the forefront of the
industry 4.0. By delivering digitalization to its electrification, robotics, automation and mation portfolio, Camptra Tech pushes the boundaries of technology to drive
performance to new levels. This is a Networking Specialist role, reporting to the Technical Manager in business area Process Automation located in Bangalore. You wil
be working at Ability Innovation Centre (AIC), home to the largest technology and engineering pool in Camptra Tech globally and is a part of Campra Tech Global
Industries and Services Private Limited, a subsidiary of Camptra Tech. It is based in Bangalore. the silicon-valley of India. Its unique infrastructure places research.
development, engineering, and service teams under one oo, increasing collaboration and reducing time to market, with no compromise on qualty. If you are looking
for an environment that actively blends the boundaries between technology. data, domain and Industrial Al to create next generation analytics solutions for processes

Next, in the Skills section, click Add and enter the information. Click Save then,
Continue




Create Job Requisition

o [ sow ][ |
it i3 ‘ R o B £

(® Requisition Structure [ 7t

(5) Details

/it

(8) Posting Description [ £ m

(7 E

Jab Coding Sklis

Enternthe below/information

Click Continue Continge

| Cancel ‘
Suggested Skils Required
ok Click Save
“still Importance
‘ Medium

Next, in the Offer Info section, update the information, if applicable. Click

Continue

Create Job Requisition

(@) Skills

FETTR T, &

(8) Posting Description

Save and Close
‘ 4 it ‘

‘ / Kt ‘

O Offer Info

Update)the below/information, iftapplicable

Legal Employer

Primary Work Location

‘ HR - Recruitment

| Revebtutor Us nc v [compeota .
) Other Work Locations
Business Unit
. y ‘ Select a value v
| camptra Us Business ni -
Add Another Work Location
Department
Job

‘ Select avalue

Click Continue Continye

Next, in the Attachments section, upload an attachment, if applicable and click

Continue

73
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Create Job Requisition

G, (Zueme.
(5) Posting Description [ s |
@ Skills [/ ]
(8) Offer Info [ 76

° Attachments

/2

Drag files here or click o add attachment v

Click Continue Continue

Next, in the Configuration section, enter the Candidate Selection Process,
External Application Flow, Allow Candidates to Apply When Not Posted, and
Automatically Fill Requisition. Click Continue

Create Job Requisition

(®) Posting Description [ e |
@ Skills [/ |
(® Offer info [ e |
(® Attachments [ e |
@ Configuration Update)the below/information, if/applicable

“Candidate Selection Process Allow Candidates to Apply When Not Posted

=] [res ~]
“External Application Flow Automatically Fill Requisition
[ Nk Application Flow - ORAC INTERN FLOW -] [ ves V]

Lastly, in the Questionnaires section, add an Internal or External prescreening
qguestion, if applicable. We can also attach an Interview Questionnaire.

]
74|
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22 140
1" How will you rate your communication skills?

Question Code Question Classification
3000001213057 Prescreening Question Added Automatically
Question Type ¥ Requires Response
Single Choice
{7 How will you rate your technical sidls?
Question Code Question Classification
3000001213053 Prescreening Question Added Automatically
Question Type ¥ Requires Response
Single Choice
(21 How many years of experience do you have in this field?
Question Code Question Classification
3000001213043 Prescreening Question Added Automatically
Question Type ¥ Requires Response
Single Choice
Which of the following languages have you worked with for more than a year? x
Question Code Question Classification
AQNK Prescreening Question Added by User
Question Type ¥ Requires Response
Multiple Choice

Maximum Pgssible Score 10

Click Dropdown to Add Questionnaire

Interview Questionnaires

Add Questionnaire

[selectavalue N

Click Submit
Create Job Requisition Soveand Cose | =

Click Submit

®

Basic Info

Hiring Team [ 7 s

®

®

Requistion Structure
(& Detalls [ 7

(&) Posting Descriotion [ 7]

/it

@ sis

(&) OfferInfo [ £ ]

Posting A Requisition In Draft Status
Navigation: My Client Groups>Hiring>Add>Save and Close

From the home screen, click My Client Groups




Good afternoon, Michael Burke!
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Job Requisitions

" B I z s i BB : /
Requisitions
Job Requisitions

o Click Add
Keywords Q| showFilters  Hiring Team Role  Recruiter, Hiring Manager, Collaborator X

Q Cancidate Search

Sort By | Creation Date - New to Olc v

<l Campaigns Solution Specialists PA (65) Applications: 0

Open - Posted Prospects: 0
) candidate Pools Standard

Bellevue, DC, United States
% Job Offers PA_test1 (64) Applications: 0

Open - Pasted Prospects: 0

Standard

United States

Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

Network Specialist-NK (57) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

PA HRIS Manager (54) Applications: 0
Open - Posted Prospects: 0

In the How section, select the Requisition Type; Standard will default. Under Use,
select Job or Position. Next, update the Business Unit, if applicable and using the
assistive search, enter the Job. Once the information is entered, click Continue

Create Job Requisition

How ; :

° Enterthe belowjinformation
Requisition Type Business Unit
[standera ‘] [ camptea U Business Unic Y]
“Use *Job
[0 ‘] [cene v]

Continue
Click Continue
(2) Basic Info

) Hring Team

Next, in the Basic Info section, enter the Requisition Title, the Number of
Openings, if greater than 1, the Business Justification, and the Languages, if
applicable. Click Continue

]
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Create Job Requisition

() How

Save and Close Submit

‘ / Edit ‘

@ BasicInfo

Entersthe below/information

Requisition Type
Standard

*Requisition Title

Business Justification

[ etecta value v

‘ Languages

“Number of Openings

[ American Engiish

| Limited

1

(3) Hiring Team

4) Requisition Structure

Continue
Click Continue

Next, in the Hiring Team section, update or enter the information below, if needed,

and click Continue

Create Job Requisition

(M How

(@) Basic Info

/ Edit

/ Edit

@ Hiring Team

Enterthe below/information

*Hiring Manager

*Recruiter

| Michael Burke Manager

= ‘ [Jack Recruter Analyst v

Add Collaborator Type

Collaborator

| tack Davies Consultant

v [x

Add Another Collaborator

Continue
Click Continue

(#) Requisition Structure [ s |

Next, in the Requisition Structure section, enter the information below, and click
Continue

]
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Create Job Requisition

(3 How /' Edit

(2) Basic Info / Eit

(3) Hiring Team 7w
@ Requisiton Structure Enterthe below/information

Recruiting Type Other Locations

Piofeidnal ‘ Select a value v

*Organization

Camptra Org

Primary Location
United States

Continue
Click Continue

Next, in the Details section, enter the information below and click Continue

Create Job Requisition

= LSS
@ Details . ;
nterathe below/information
Full Time or Part Time Job Shift
Worker Type Job Type
Employee -] [ standard v
Regular or Temporary Education Level
Regular -] [Post-First rofessiona v

Management Level

Compensation Currency Maximum Salary

Us Dollar -] [ 120,000
Pay Frequency Minimum Salary
Annually -] [ 90,000
Budget Currency Travel Budget
US Dollar | [ 1500
Employee Referral Bonus Relocation Budget
1,000 [ 500

Sourcing Budget

“Department

HR - Recruitment

Click Continue ntinue

Next, in the Posting Description section, enter the Posting Description for Internal
Candidates; this is the job name. To update the posting description, click Enter
Custom Internal Positing Description to make this section editable and enter the
applicable updates. Once complete, click Continue

]
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Create Job Requisition Save and Close

@ Posting Description

Posting Description for Internal Candidates

Network Specialist_NK

Short Description for Internal Candidates

Click Check box

Updatejthejbelowjinformation

Description for Internal Candidates

&

Network Specialist

Take your next career step at Camptra Tech with a global team that is energizing the transformation of society and industry to achieve a more productive,
sustainable future. At Camptra Tech, we have the clear goal of driving diversity and inclusion across all dimensions: gender, LGBTQ+, abilities, ethnicity
and generations. Together, we are embarking on a journey where each and every one of us, individually and collectively, welcomes and celebrates
individual differences.

Camptra Tech is a leading global technology company that energizes the transformation of society and industry to achieve a more productive, sustainable future. With
a history of excellence stretching back more than 130 years, Camptra Tech has been a pioneer through the four Industrial revolutions and is at the forefront of the
industry 4.0. By delivering digitalization to its electrification, roboltics, automation and motion portfolio, Camptra Tech pushes the boundaries of technology to drive:
performance to new levels. This is a Networking Specialist role, reporting to the Technical Manager in business area Process Automation located in Bangalore. You will
be working at Ability Innovation Centre (AIC), home to the largest technology and engineering pool in Camptra Tech globally and is a part of Camptra Tech Global
Industries and Services Private Limited, a subsidiary of Camptra Tech. It s based in Bangalore, the silicon-valley of India. lts unique infrastructure places research
development, engineering, and service teams under one roof, increasing collaboration and reducing time to market, with no compromise on qualty. If you are looking
for an environment that actively blends the boundaries between technology. data, domain and Industrial Al to create next generation analytics solutions for processes

Next, in the Skills section, click Add and enter the information. Click Save then,
Continue

Create Job Requisitio

(¥ Requisition Structure [ £ |
(5) Details e
(8) Posting Description [ £ 5|

0 < Enter:the below/information

Jab Coding Sklis

Suggested Skils Required
= s Select v ick Save
“skill Importance
| Medium v

Next, in the Offer Info section, update the information, if applicable. Click
Continue




Create Job Requisition

WY VIR N AN FEVIE TR, & )
(&) Posting Description [/ |
@ Skills | 7 e |
0 offer nfo Update)the below/information, ifapplicable

Legal Employer Primary Work Location

| RPebutorUsa nc ‘| | comprate ‘|

Other Work Locations
Business Unit

. . ‘Seledavalue v ‘
‘(amptra US Business Unit v ‘
Department
Job
‘HR-Reuuitmen: v ‘
‘Selsdavalus v ‘

Click Continue Continue

Next, in the Attachments section, upload an attachment, if applicable and click
Continue

Create Job Requisition

"S(.)Y S

-

(8) Posting Description [ /e |
(@) Skills [ /et |
Offer Info [ 7

@ Attachments

/2

Drag files here or click o add attachment v

Click Continue Continue

Next, in the Configuration section, enter the Candidate Selection Process,
External Application Flow, Allow Candidates to Apply When Not Posted, and
Automatically Fill Requisition. Click Continue

—
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Create Job Requisi

(®) Posting Description [ e |
@ Skills [ ean |
Offer Info [ e |

(® Attachments 7 et |

@ Configuration Update)the below/information, ifiapplicable

A A

*Candidate Selection Process Allow Candidates to Apply When Not Posted
[ NK Candidate Selection Process - NKcP002 ] [ves ]
“External Application Flow Automatically Fill Requisition

[ Nk Application Flow - ORAC INTERN FLOW [ves

Continue

Click Continue

Lastly, in the Questionnaires section, add an Internal or External prescreening
guestion, if applicable. We can also attach an Interview Questionnaire.

Create Job Requisiti

CEVERETRY. &
(1" How will you rate your communication skills?

Question Code Question Classification
300000011213057 Prescreening Question Added Automatically
Question Type ¥ Requires Response

Single Choice

1 How will you rate your technical skills?

Question Code Question Classification

3000001213053 Prescreening Question Added Automatically
Question Type ¥ Requires Response

Single Choice

21 How many years of experience do you have in this field?
Question Code Question Classification
3000001213043 Prescreening Question Added Automatically
Question Type ¥ Requires Response
Single Choice
Which of the following languages have you worked with for more than a year? x
Question Code Question Classification
AQNK Prescreening Question Added by User
Question Type

VI Requires Response

Multiple Choice

Maximum Pgssible Score 10

Interview Questionnaires Click Dropdown to Add Questionnaire

Add Questionnaire

[selecta value v

Click Save and Close. The requisition will remain in draft status until the recruiter
clicks Submit.

]
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Create Job Requisition [ Save and Close

a2 Click Save and Close

@ How [ 7 e

(@ Basic Info [ e ]
(®) Hiring Team [/ e
(@ Requisition Structure [ et
(& Detalls [z e ]
(&) Posting Description [ e

@ skills [ 7 s |

® Offer Info [ 2 e

From the Job Requisition tab, we can view this requisition in Draft - In Progress
status

Job Requisitions
le
Requisitions B
Job Requisitions
) Show iters | [ Hing TeamRle | Reter, Hifg Manager,Clltorstor X
X Candidate Search
Sort By | Creation Date - New to Ol v
<l Campaigns Network Specialist (75)
Draft - In Progress
3 Candidate Pools Standard
United States
‘E\ Job Offers Solution Specialists PA (65) Applications: 0
Open - Posted Prospects: 0
Standard

Bellevue, DC, United States

PA test1 (64) Applications: 0
Open - Posted Prospects: 0
Standard

United States

Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard

CA, Unitec States

Posting A Requisition In Job Formatting In Progress Status
Navigation: My Client Groups>Hiring>Add>Submit

From the home screen, click My Client Groups

]
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Good afternoon, Michael Burke!

roups

Click My Client Groups

QUICK ACTIONS.
Hire an Empl
ontingent Worker
Add a Pending

Pending Wi Goals

ent Contras

Talent Pools
Location
Change Working Hours

+

Promote

Click Hiring

Joumeys

&l

Performance

&8y

Workforce
Structures

Good afternoon, Michael Burke!

/ Team My Client Groups

QUICK ACTIONS.
Hire an Emplos
Add a Contingent Worker
Add a Pending Worl
Add a Nonworker

Pending Workers

Talent Pools

Change Location
ange Working Hours

4‘,

Promot

Click Add

Journeys

Click
il

Performance

4

Workforce
Structures

Help Desk My En

\%*

New Person

Person Absences

Management

(@] el

AC=d|

Talent Review Succession Plans

—
] ) &=
Waorkforce Data Exchange

Mass Updates
Modeling

Enterp

O *

[B4]

New Person

erson
Management

(e lje]

Cs=]

Talent Review ccession Plans

i} 23 =

Data Exchange

Workforce

Mass Updates
Modeling

>




Job Requisitions

" B I z s i BB : /
Requisitions
Job Requisitions

o Click Add
Keywords Q| showFilters  Hiring Team Role  Recruiter, Hiring Manager, Collaborator X

Q Cancidate Search

Sort By | Creation Date - New to Olc v

<l Campaigns Solution Specialists PA (65) Applications: 0

Open - Posted Prospects: 0
) candidate Pools Standard

Bellevue, DC, United States
% Job Offers PA_test1 (64) Applications: 0

Open - Pasted Prospects: 0

Standard

United States

Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

Network Specialist-NK (57) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

PA HRIS Manager (54) Applications: 0
Open - Posted Prospects: 0

In the How section, select the Requisition Type; Standard will default. Under Use,
select Job or Position. Next, update the Business Unit, if applicable and using the
assistive search, enter the Job. Once the information is entered, click Continue

Create Job Requisition

How ; :

° Enterthe belowjinformation
Requisition Type Business Unit
[standera ‘] [ camptea U Business Unic Y]
“Use *Job
[0 ‘] [cene v]

Continue
Click Continue
(2) Basic Info

) Hring Team

Next, in the Basic Info section, enter the Requisition Title, the Number of
Openings, if greater than 1, the Business Justification, and the Languages, if
applicable. Click Continue

]
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Create Job Requisition

() How

Save and Close Submit

‘ / Edit ‘

@ BasicInfo

Entersthe below/information

Requisition Type
Standard

*Requisition Title

Business Justification

[ etecta value v

‘ Languages

“Number of Openings

[ American Engiish

| Limited

1

(3) Hiring Team

4) Requisition Structure

Continue
Click Continue

Next, in the Hiring Team section, update or enter the information below, if needed,

and click Continue

Create Job Requisition

(M How

(@) Basic Info

/ Edit

/ Edit

@ Hiring Team

Enterthe below/information

*Hiring Manager

*Recruiter

| Michael Burke Manager

= ‘ [Jack Recruter Analyst v

Add Collaborator Type

Collaborator

| tack Davies Consultant

v [x

Add Another Collaborator

Continue
Click Continue

(#) Requisition Structure [ s |

Next, in the Requisition Structure section, enter the information below, and click
Continue

]
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Create Job Requisition

(3 How /' Edit

(2) Basic Info / Eit

(3) Hiring Team 7w
@ Requisiton Structure Enterthe below/information

Recruiting Type Other Locations

Piofeidnal ‘ Select a value v

*Organization

Camptra Org

Primary Location
United States

Continue
Click Continue

Next, in the Details section, enter the information below and click Continue

Create Job Requisition

= LSS
@ Details . ;
nterathe below/information
Full Time or Part Time Job Shift
Worker Type Job Type
Employee -] [ standard v
Regular or Temporary Education Level
Regular -] [Post-First rofessiona v

Management Level

Compensation Currency Maximum Salary

Us Dollar -] [ 120,000
Pay Frequency Minimum Salary
Annually -] [ 90,000
Budget Currency Travel Budget
US Dollar | [ 1500
Employee Referral Bonus Relocation Budget
1,000 [ 500

Sourcing Budget

“Department

HR - Recruitment

Click Continue ntinue

Next, in the Posting Description section, enter the Posting Description for Internal
Candidates; this is the job name. To update the posting description, click Enter
Custom Internal Positing Description to make this section editable and enter the
applicable updates. Once complete, click Continue

]
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Create Job Requisition Save and Close

@ Posting Description

Posting Description for Internal Candidates

Network Specialist_NK

Short Description for Internal Candidates

Click Check box

Updatejthejbelowjinformation

Description for Internal Candidates

&

Network Specialist

Take your next career step at Camptra Tech with a global team that is energizing the transformation of society and industry to achieve a more productive,
sustainable future. At Camptra Tech, we have the clear goal of driving diversity and inclusion across all dimensions: gender, LGBTQ+, abilities, ethnicity
and generations. Together, we are embarking on a journey where each and every one of us, individually and collectively, welcomes and celebrates
individual differences.

Camptra Tech is a leading global technology company that energizes the transformation of society and industry to achieve a more productive, sustainable future. With
a history of excellence stretching back more than 130 years, Camptra Tech has been a pioneer through the four Industrial revolutions and is at the forefront of the
industry 4.0. By delivering digitalization to its electrification, roboltics, automation and motion portfolio, Camptra Tech pushes the boundaries of technology to drive:
performance to new levels. This is a Networking Specialist role, reporting to the Technical Manager in business area Process Automation located in Bangalore. You will
be working at Ability Innovation Centre (AIC), home to the largest technology and engineering pool in Camptra Tech globally and is a part of Camptra Tech Global
Industries and Services Private Limited, a subsidiary of Camptra Tech. It s based in Bangalore, the silicon-valley of India. lts unique infrastructure places research
development, engineering, and service teams under one roof, increasing collaboration and reducing time to market, with no compromise on qualty. If you are looking
for an environment that actively blends the boundaries between technology. data, domain and Industrial Al to create next generation analytics solutions for processes

Next, in the Skills section, click Add and enter the information. Click Save then,
Continue

Create Job Requisitio

(¥ Requisition Structure [ £ |
(5) Details e
(8) Posting Description [ £ 5|

0 < Enter:the below/information

Jab Coding Sklis

Suggested Skils Required
= s Select v ick Save
“skill Importance
| Medium v

Next, in the Offer Info section, update the information, if applicable. Click
Continue




Create Job Requisition

WY VIR N AN FEVIE TR, & )
(&) Posting Description [/ |
@ Skills | 7 e |
0 offer nfo Update)the below/information, ifapplicable

Legal Employer Primary Work Location

| RPebutorUsa nc ‘| | comprate ‘|

Other Work Locations
Business Unit

. . ‘Seledavalue v ‘
‘(amptra US Business Unit v ‘
Department
Job
‘HR-Reuuitmen: v ‘
‘Selsdavalus v ‘

Click Continue Continue

Next, in the Attachments section, upload an attachment, if applicable and click
Continue

Create Job Requisition

"S(.)Y S

-

(8) Posting Description [ /e |
(@) Skills [ /et |
Offer Info [ 7

@ Attachments

/2

Drag files here or click o add attachment v

Click Continue Continue

Next, in the Configuration section, enter the Candidate Selection Process,
External Application Flow, Allow Candidates to Apply When Not Posted, and
Automatically Fill Requisition. Click Continue

—
(0]
©
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Create Job Requisi

(®) Posting Description [ e |
@ Skills [ ean |
Offer Info [ e |

(® Attachments 7 et |

@ Configuration Update)the below/information, ifiapplicable

A A

*Candidate Selection Process Allow Candidates to Apply When Not Posted
[ NK Candidate Selection Process - NKcP002 ] [ves ]
“External Application Flow Automatically Fill Requisition

[ Nk Application Flow - ORAC INTERN FLOW [ves

Continue

Click Continue

Lastly, in the Questionnaires section, add an Internal or External prescreening
guestion, if applicable. We can also attach an Interview Questionnaire.

Create Job Requisiti

CEVERETRY. &
(1" How will you rate your communication skills?

Question Code Question Classification
300000011213057 Prescreening Question Added Automatically
Question Type ¥ Requires Response

Single Choice

1 How will you rate your technical skills?

Question Code Question Classification

3000001213053 Prescreening Question Added Automatically
Question Type ¥ Requires Response

Single Choice

21 How many years of experience do you have in this field?
Question Code Question Classification
3000001213043 Prescreening Question Added Automatically
Question Type ¥ Requires Response
Single Choice
Which of the following languages have you worked with for more than a year? x
Question Code Question Classification
AQNK Prescreening Question Added by User
Question Type

VI Requires Response

Multiple Choice

Maximum Pgssible Score 10

Interview Questionnaires Click Dropdown to Add Questionnaire

Add Questionnaire

[selecta value v

Click Save and Close. The requisition will remain in draft status until the recruiter
clicks Submit.
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Create Job Requisition

Click Save and Close

o =)
(@ Basic Info [ e ]
(®) Hiring Team [/
(@ Requisition Structure [ et
(& Detalls [z e ]
(&) Posting Description [ e
@ skills [ &)
® Offer Info [ e ]

From the Job Requisition tab, we can view this requisition in Draft - In Progress
status.

Job Requisitions
le
Requisitions B
Job Requisitions
Keywords Q| ShowFilters | Hiring TeamRole = Recruiter, Hiring Manager, Collatorator X
\ Candidate Search
Sort By | Creation Date - New to Ol v
<l Campaigns Network Specialist (75)
Draft - In Progress
3 Candidate Pools Standard
United States
‘EI Job Offers Solution Specialists PA (65) Applications: 0
Open - Posted Prospects: 0
Standard

Bellevue, DC, United States

PA test1 (64) Applications: 0
Open - Posted Prospects: 0
Standard

United States

Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard

CA, Unitec States

To post a Draft Job Requisition, select the Job Requisition Name




Job Requisitions

O Requisitions X
Job Reguisitions
| Keywords S| ShowFiters Hiring Team Role  Recruiter. Hiring Marager, Collaborator X
Candidzte Search —
Sort By | Creation Date - New to Olc }
<] campaigns

() Candidate Pools Click Job Requisition

Unitec
=] Job Offers Solution Specialists PA (65) Applications: 0
Open - Posted Prospects: 0

e DC, United States

PA_testl (64) Applications: 0
Prospects. 0

Open

Applications: 3

Prospects 0
CA, United Stztes
Network Specialist-NK (57) Applications: 3
Prospects. 0

Ch. United Stetes

Click Submit to move the requisition from Draft Status to Job formatting - In
Progress

Network Specialist Svaand Closa b submit

75

Click Submit

@ Basic Info

Requisition Type Requisition Template
Stndad ‘Ne(wmk Specialist-NK (NetwrkSpec-NK) v]
Requisition Number

75 Business Justification

“Requisition Title ‘ Selecca valug id ‘
| Network specialist | Languages

“Number of Openings | American English

[ imited A1 1

From the Job Requisition tab, we can view this requisition in Job formatting - In
Progress status

]
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Job Requisitions

le
Requisitions
Job Requisitions
Keywords Q| ShowFilters | Hiring Team Role Recruiter, Hiring Manager, Collaborator X
< Candidate Search
'.VU Campaigns Network Specialist (75)

Job formatting - In Progress
] Candidate Pools Standard
United States

Solution Specialists PA (65)
Open - Posted
Standard

Bellevue, DC, United States

PA_testl (64)
Open - Posted
Standard

United States

Network Specialist-NK (60)
Open - Posted
Standard

CA, United States

Network Specialist-NK (57)
Open - Posted
Standard

CA, United States

Applications: 0

Prospects: 0

Applications: 0
Prospects: 0

Applications: 3
Prospects: 0

Applications: 3
Prospects: 0

Sort By | Creation Date - New to Olc v/

Posting A Requisition In Posting In Progress Status
Navigation: My Client Groups>Hiring>Add>Submit>Job

Formatting>Actions>Move to Posting

From the home screen, click My Client Groups

Good afternoon, Michael Burke!

My Team
QUICK ACTIONS

Hire an Employea
O *
" Add a Contingent Worker

Journeys New Person

" Add a Pending Worker

il

Pending Workers Performance

&2y ]

Talent Pools Workforce Mass Updates
Structures

1ange Location

Change Working Hours

+

Click Hiring

Person
Management

Talent Review

¥

Warkforce
Modeling

Help Desk My Ents

Lo

=]

Succession Plans

=

Data Exchange

]
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Good afternoon, Michael Burke!

Me

My Team

QUICK ACTIONS

Hire an Employ

Add a Contingent Worker

Add a Pending Werker

Add a Nenworker

Pending Warkers

Employment Contracts

Change Location

Change Working Hours

Click Add

Job Requisitions

Talent Pools

+

Journeys

O *

New Person

Click Hiring

il

Performance

&

Workforce

]

Mass Updates

Structures

Person
Management

Telent Review

]

Workforce
Modeling

My Enterp »

(ele]

Gs=]

Succession Plans

=

Data Exchange

l¢

@an Requisitions

{ Candidate

Search

5 H Campaigns

D candidate Pools

=

-_1 Job Offers

Requisitions

Keywords

Solution Specialists PA (65)
Open - Posted

Standard

Bellevue, DC, United States

PA_test1 (64)
Open - Posted
Standard
United States.

Network Specialist-NK (60)
Open - Posted

Standard

CA, United States

Network Specialist-NK (57)
Open - Posted

Standard

CA, United States

PA HRIS Manager (54)
OEer - Posted

Q

\ Show Filters

Hiring Team Role ~ Recruiter, Hiring Manager, Collaborator %

Applications: 0
Prospects: 0

Applications: 0
Prospects: 0

Applications: 3
Prospects: 0

Applications: 3
Prospects: 0

Applications: 0
Prospects: 0

Click Add

Sort By | Creation Date - New to Olc v

In the How section, select the Requisition Type; Standard will default. Under Use,
select Job or Position. Next, update the Business Unit, if applicable and using the
assistive search, enter the Job. Once the information is entered, click Continue

—
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Create Job Requisition

‘ Saveand Close ‘ Submit ‘ Cancel

terthe below/information

Q How i
Recisition Type
‘ Standard v ‘
“Use
‘Jnh v ‘

Business Unit

‘ Camptra US Business Unit

*Job

‘ Clerk

(2) Basic Info

(8) Hiring Team

(4) Requisition Structure

Continge
Click Continue

Next, in the Basic Info section, enter the Requisition Title, the Number of
Openings, if greater than 1, the Business Justification, and the Languages, if

applicable. Click Continue

Create Job Requisition

(V) How

Save and Close Submit

‘ 4 Edit ‘

*Requisition Title

0 sasic nfo Entefthe below/information
Requisition Type Business Justification
Standard

[ etecta value

‘ Languages

“Number of Openings

| American English

| Limited v ‘ ‘

1

(4) Requisition Structure

Contine
Click Continue

Next, in the Hiring Team section, update or enter the information below, if needed,

and click Continue

—
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Create Job Requisition

@ How @

(2) Basic Info / it

@ Hiing Team Enterthe belowjinformation

*Hiring Manager *Recruiter

| Michael Burke Manager V] [Jack Recruiter Analyst &

Add Collaborator Type

Collaborator

| tack Davies Consutant v]x

Add Another Collaborator

Continue
Click Continue

(4) Requisition Structure [ 2 et ]

Next, in the Requisition Structure section, enter the information below, and click
Continue

Create Job Requisition

() How
(2) Basic Info
(3) Hiring Team

© Requisiion Structure Ententhe belowjinformation
Recruiting Type Other Locations
Professional ‘ Select a value b
*Organization Another Location

Camptra Org

Primary Location

United States

Continue
Click Continue

Next, in the Details section, enter the information below and click Continue

]
% |
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Create Job Requisition sovoand Glose | [ submie |

R toir S X
@ Details f ;
Entersthe below/information
Full Time or Part Time Job Shift
Full time -] [ay v
Worker Type Job Type
Regular or Temporary Education Level
Regular -] [ Post-first rofessional v

Management Level

Senior manager -]
Compensation Currency Maximum Salary

Us Dollar | ( 120,000
Pay Frequency Minimum Salary

Annually -] [ 90,000
Budget Currency Travel Budget

US Dollar -] [ 1500
Employee Referral Bonus Relocation Budget

1000 | ( 500

Sourcing Budget

“Department

HR - Recruitment v

Next, in the Posting Description section, enter the Posting Description for Internal
Candidates; this is the job name. To update the posting description, click Enter
Custom Internal Positing Description to make this section editable and enter the
applicable updates. Once complete, click Continue

Create Job Requisition

[saveandciose | [ submit |

PN R 5 o B o & _—

(® Details 7 Ear

@ Posting Description

Posting Description for Internal Candidates

Network Specialist NK

nter Custom Internal Posting Description

Short Description for Internal Candidates

Click Check box

\WUpdate)thebelow/information

Description for Internal Candidates Ussss st

®

Network Specialist

Take your next career step at Camptra Tech with a global team that is energizing the transformation of society and industry to achieve a more productive,
sustainable future. At Camptra Tech, we have the clear goal of driving diversity and inclusion across all dimensions: gender, LGBTQ+, abilities, ethnicity
and generations. Together, we are embarking on a journey where each and every one of us, individually and collectively, welcomes and celebrates
individual differences.

Camptra Tech is a leading global technology company that energizes the transformation of society and industry to achieve a more productive, sustainable future. With
a history of excellence stretching back more than 130 years, Camptra Tech has been a pioneer through the four Industrial revolutions and is at the forefront of the
industry 4.0. By delivering digitalization to its electrification, robotics, automation and mation portfolio, Camptra Tech pushes the boundaries of technology to drive
performance to new levels. This is a Networking Specialist role, reporting to the Technical Manager in business area Process Automation located in Bangalore. You wil
be working at Ability Innovation Centre (AIC), home to the largest technology and engineering pool in Camptra Tech globally and is a part of Campra Tech Global
Industries and Services Private Limited, a subsidiary of Camptra Tech. It is based in Bangalore. the silicon-valley of India. Its unique infrastructure places research.
development, engineering, and service teams under one oo, increasing collaboration and reducing time to market, with no compromise on qualty. If you are looking
for an environment that actively blends the boundaries between technology. data, domain and Industrial Al to create next generation analytics solutions for processes

Next, in the Skills section, click Add and enter the information. Click Save then,
Continue




Create Job Requisition

o [ sow ][ |
it i3 ‘ R o B £

(® Requisition Structure [ 7t

(5) Details

/it

(8) Posting Description [ £ m

(7 E

Jab Coding Sklis

Enternthe below/information

Click Continue Continge

| Cancel ‘
Suggested Skils Required
ok Click Save
“still Importance
‘ Medium

Next, in the Offer Info section, update the information, if applicable. Click

Continue

Create Job Requisition

(@) Skills

FETTR T, &

(8) Posting Description

Save and Close
‘ 4 it ‘

‘ / Kt ‘

O Offer Info

Update)the below/information, iftapplicable

Legal Employer

Primary Work Location

‘ HR - Recruitment

| Revebtutor Us nc v [compeota .
) Other Work Locations
Business Unit
. y ‘ Select a value v
| camptra Us Business ni -
Add Another Work Location
Department
Job

‘ Select avalue

Click Continue Continye

Next, in the Attachments section, upload an attachment, if applicable and click

Continue

98
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Create Job Requisition

G, (Zueme.
(5) Posting Description [ s |
@ Skills [/ ]
(8) Offer Info [ 76

° Attachments

/2

Drag files here or click o add attachment v

Click Continue Continue

Next, in the Configuration section, enter the Candidate Selection Process,
External Application Flow, Allow Candidates to Apply When Not Posted, and
Automatically Fill Requisition. Click Continue

Create Job Requisition

(®) Posting Description [ e |
@ Skills [/ |
(® Offer info [ e |
(® Attachments [ e |
@ Configuration Update)the below/information, if/applicable

“Candidate Selection Process Allow Candidates to Apply When Not Posted

=] [res ~]
“External Application Flow Automatically Fill Requisition
[ Nk Application Flow - ORAC INTERN FLOW -] [ ves V]

Lastly, in the Questionnaires section, add an Internal or External prescreening
qguestion, if applicable. We can also attach an Interview Questionnaire.

]
9 |
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Create Job Requisiti

CENERTEIT &
1" How will you rate your communication skills?

Question Code Question Classification

300000011213057 Prescreening Question Added Automatically
Question Type ¥ Requires Response

Single Choice

{7 How will you rate your technical sidls?

Question Code Question Classification
300000011213053 Prescreening Question Added Automatically
Question Type ¥ Requires Response

Single Choice

(% How many years of experience do you have in this field?

Question Code Question Classification

300000011213043 Prescreening Question Added Automatically
Question Type ¥ Requires Response

Single Choice

Which of the following languages have you worked with for more than a year?

Question Code Question Classification
AQNK Prescreening Question Added by User
Question Type

¥ Requires Response

Multiple Choice

Click Dropdown to Add Questionnaire

Interview Questionnaires

Add Questionnaire

[selectavalue N

Maximum Pgssible Score 10

Click Save and Close. The requisition will remain in draft status until the recruiter

clicks Submit.

Create Job Requisition

Click Save and Close

How
Basic Info
Hiring Team

Requisition Structure

Posting Description

Skills

®
®
®
®
(3 Detalls
®
@
®

Offer Info

‘ # Edit ‘

‘ # Edit ‘
‘ 4 Edit ‘
‘ / Edit ‘

‘ 7 Edit ‘

‘ / Edit ‘

‘ 7 Edit ‘

[ 7 e ‘

From the Job Requisition tab, we can view this requisition in Draft - In Progress

status

]
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Job Requisitions

¢
@ Requisitions |+ aa |

Job Requisitions
~ Keywords Q| ShowFilters | Hiring TeamRole = Recruiter, Hiring Manager, Collatorator %
X Candidate Search
Sort By | Creation Date - New to Olc v
o Campaigns Network Specialist (75)
Draft - In Progress
3 Candidate Pools Standard
United States
& Job Offers Solution Speciaists PA (65) Applctons:0
Open - Posted Prospects: 0
Standard

Bellevue, DC, United States

PA test (64) Applications: 0
Open - Posted Prospects: 0
Standard

United States

Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard

CA, Unitec States

To post a Draft Job Requisition, select the Job Requisition Name

Job Requisitions

Requisitions [+ |
E Job Requisitions

| Keywords Q| showFilters | | Hiing Team Role  Recruter. Hiring Marager, Collaborator X

<, Candidate Search e —
Sort By | Creation Date - New to Olc v/ 1

<] campaigns

() Candidate Pools Click Job Requisition

B Job offers Applications: 0

Prospects: 0
Bellevue DC, United States

PA_testl (64) Applications: 0
Open - Fost Prospects: 0

Applications: 3

Prospects: 0

CA, United Stztes

Network Specialist-NK (57) Applications: 3
& Prospects 0

Click Submit to move the requisition from Draft Status to Job formatting - In
Progress

]
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Network Specialist sevaand Closa b submit

75
Click Submit

© Basic nfo

Requisition Type Requisition Template
Standard

‘ Network Specialist-NK (NetwrkSpec-NK) v ‘

Requisition Number
Business Justification

*Requisition Title ‘Se[enavalue v ‘
[ Network Specialst | Languages

“Number of Openings \ American English

[ imited A1 1‘

From the Job Requisition tab, we can view this requisition in Job formatting - In
Progress status

Job Requisitions

I
Requisitions [+ e |
Job Requisitions
Show Fiters | [[Hinng Team Role | Recruitr, Hiring Manager, Collsborator X
- Candidate Search
Sort By | Creation Date - New to Ole
<1 Campaigns Network Specialist (75)
Job formatting - In Progress
1 candidate Pools Standard
United States.
1) Job Offers Solution Specialists PA (65) Applications:0
Open - Posted Prospects: 0
Standard

Bellevue, DC, United States

PA_test1 (64) Applications: 0
Open - Posted Prospects: 0
Standard

United States

Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

Network Specialist-NK (57) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

To move the requisition to Posting In Progress status, click Job Requisition

]
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Job Requisitions

Requisitions B

=] b Requisitions

Keywords Q|  ShowFilters | HiringTeam Role ~ Recruiter, Hiring Manager, Collaborator x

{Candidate Search

Sort By | Creation Date - New to Olc

<] campaigns Network specialist (75),

Tob Tormatting T Progress

{3 candidate Pools Standard
United States

Click Job Requisition

% Job Offers Solution Specialists PA (65)

Open - Posted

Applications: 0
Prospects: 0
Standard

Bellevue, DC, United States

PA testl (64)
Open - Posted

Applications: 0
Prospects: 0

Standard

United States

Network Specialist-NK (60)
Open - Posted

Applications: 3
Prospects: 0
Standard

CA, United States

Network Specialist-NK (57)
Open - Posted

Applications: 3
Prospects: 0
Standard

CA, United States

From the Job Formatting tab, click Actions then Move to Posting

¢ Network Specialist: Job Formatting

/5

Actions ¥ ‘
e |

Open or Sourcing

Preview Jeb Requistor

le
Transiate .0b Requis tion
Employer Description

- § Send Message fo Teem
Overview

Internal External Link tc Fip2iine Fequisiion
= NK Employer Description Same as Internal Redat Job Requisition

Details

Canzel Job Requistien

ob Formatting

P2 interactions

B interviews

2 Progress

Recruiting Organization Description

Interal
N Recruiting Oranisation Description

Media
All Languages v

Edit | A

External
Same as Internal

‘ + Add | A

, There's nothing here so far.

From the Job Requisition tab, we can view this requisition in Posting - In Progress

status

—
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Requisizions + Add

(=0 Reaquisitions

_ ‘mwwm | ShowFilters |  HiringTeam Role = Recruiter, Hiring Manager, Collaborator X
" Candidate Search -
Sort By | Creaton Date - New t0 Ol
Campaigns Network Specialist (75)
Posting - In Progress
(Y candicate Pools 3
Urited States
155 Job offers Solution Specialists PA (65) Applications: 0

Open - Fosted Prospacts: 0

Bellevue, DC, United Statss

PA_testl (64) Applications; 0
Fosted Prospacts: 0

Network Specialist-NK (60) Applications: 3
- Fosted Prospects: 0

CA, Urited States

Network Specialist-NK (57) Applications: 3

Open - Fosted Prospacts: 0

External Candidate Application Process
Navigation: Career Site>Search for a Job>Apply for a Job>Submit

From a browser, navigate to the Career Site

Current Job Openings

Please click on 2 Position Title (oelow) to view 3 description of the position.

FIND 1085 NEAR LOCATION ~

ALLIOBS(19)  PROFESSIONAL(2)  TEST_JOB_FAMILY.CONV[2)  EXECUTIVE ()

Solution Specialists
N e .

Human Resource Specialist

Hey ! We use cookies. Checkout our policy

1 ACCEPT

Learn more
Accountant

Senior Cost Accountant

terp

From the Career Site, a candidate can view the available jobs below or the
candidate can search for a job using the search under Find Jobs

]
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Current Job Openings

Please click on a Position Title (below) to view 3 description of the position.

FIND 1085 NEAR LOCATION + E

Enter Job Tile or Keyword ClickSearch
ALLIOBS(5)  PROFESSIONAL(zl  TEST_JOBFAMILY.CONV Q)  EXECUTIVE ()
Solution Specialists
The Soluton Specalist i responsibl for pre-sale and post.sale actvt d mainaining the dthe client. helping to market o

o e Sareen oo o EBas o Chert St i Sl eneuaEom 5 S recs b et rammaaton.

Human Resource Specialist

A5 an HR Specialist, you will administer roll s iew hire account

§orall employecs on correct use o the paysl ystem G Work Wit e vandor on SYSta E5ses. 1ou wil SnSure he accurate i el spplication o &1
deductions and that payrall i processed on

Accountant

The Solution Specialistis responsible for pre-sale and post-sale activites, bullding and maintaining the relationship between organization and the clien, helping to market o

rganization technology, services, and capabilties to the ciient. and the planning and penetration of al areas within the clients organization.

Senior Cost Accountant

Next, the candidate should select the job to apply

Hey 1! We use cookies. Checkout our policy
Learn more

s designs, develop: tities, and co ! and industrial end users.

Eos Enterpri a 3
are s puslic company isted on the NASOAQ and e nban m scxam control reduiements. e are ooking for 3 st one Senior Cost Accountant tjoin our accounting ez

SORT BY: Relevance «

FINDJOBS NEAR LOCATION ¥ a
Human Resources( City, state, country
20PENJOBS | | LOCATIONS v | | JOBFUNCTIONS w | | POSTING DATES v | | DEPARTMENT
Click Job Name

Human Resource Specialist
Bellevue, DC, United States = Posted on 05/31/2021

As an HR Specialist, you will administer the organizations payroll system to include establishing new hire account and deactivate separated
accounts. You will provide training for all employees on correct use of the payroll system and work with the vendor on system issues. You

will ensure the accurate and timely application of garnishments and deductions and that payroll is processed on time.

PA_FRA_Research

France and 1 more * Posted on 02/23/2022

i

Scroll down and click Apply Now




Education/Experience:

BSc/MSc in Human Resources or relevant field

ABOUT US

We at Camptra Technologies started our journey in 2016 as a team of seasoned software
engineers and technology specialists. Today, we use our combined expertise to provide
solutions that are not only optimal for your business but also cost-effective and people-

oriented.

Our team of top-notch consultants have a combined experience of 75 years in the Oracle
solution space. As trusted implementation partners for business, we believe that open
communication with our clients is the key to developing relevant solutions. We focus, therefore,
on working with you every step of the way to design solutions that are efficient, dynamic and

scalable so that your business always keeps pace with industry changes.

ABOUT THE TEAM

We would like to welcome you to join our team and help us take our business manitolds ahead

APPLY NOW_

Click Apply Now

Job Identification 2 Posting Date 05/31/2021, 05:33 AM  Degree Level Master's Degree
Job Schedule Fulltime  Job shift Day

The candidate will enter their email address, agree with the terms and conditions,
and click Next

You don't need to have an account

Get started right away by simply using your email. Your profile will be created and
kept up to date automatically as you enter details for each of your job applications.

Enter Email Address

Email Address *

Testcandidate@gmail.com

gsree with the terms and conditions *

Click Check Box

4« CANCEL ‘ NEXT »

The candidate will enter the information below and click Submit




{3 | Human Resource Specialist

]
>
~

LANGUAGES

Please indiczte which lanzuages you speak.

ADD LANGUAGE

1 2gree to receive updatas about new Job opportunties

1 agree o recaive marketing communications

E-SIGNATURE

Plaase il in your ull name

Please type your full legal name *

Test Candidate| ]

Enter Full Legal Name

Internal Candidate Application Process
Navigation: Me>Current Jobs>Search>Submit

From the home screen, click Me

Good afternoon, Michael Burke!

Me My Team Ay 3enefits Administrati Sales Service C ge elp Desk My Enterp 3

QUICK ACTIONS Click Me

Medical Plan Comparison O

Directory Jourmeys Time and Career and Personal
Absences Performance Information

Personal Details

dentification Info @ f S

Learning Benefits My Benefits Company Benefits Current Jobs
Summary Portal

Family and Emerge

&%, My Organization Chart % ﬁn _|_

Safety Incidents Performance
My Public Info

Click Current Jobs




Good afternoon, Michael Burke!

Me My Team My Client Groups Benefits Administration

Sales Service Knowledge Help Desk

My Enterp 3

QUICK ACTIONS

> Medical Plan Comparison

® 08 g

Directory Joumeys Time and

Absences

Career and

Personal
Performance

Information
(=D Document Records.

Sk identfication info Horn
® ® ¥ | ®

Coaethnge Learning Benefits My Benefits Company Benefits Current Jobs
Summary Portal
mily and Emergency Contacts

Click Current Jobs

J
o - 3 Qﬁ =
(@& My Organization Chart DD

=

= Safety Incidents Performance
[&] MyPubicino

From the Current Jobs screen, the employee can search for open internal jobs,

review job applications, etc. To apply for an internal job, enter the Job Title and
Search. To search for all internal jobs, do not enter a Job Title and click Search

{ Current Jobs

Search by job tile, organization, or other keywon | Yorba Linda,CA,United States v

Click Search

A =
@ Favorite Jobs Job Applications @ Referrals Job Offers

See your preferred jobs Review the job applications you Check on the referrals you made See your job offers
submitted

@ Job Alerts

Subscribe to notifications and
manage your job preferences

This list contains the internal Jobs. To apply for an internal job, click the Job Title

108 ]
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Jabs (11)

Search... ‘

Yorba Linda,CA,United States -
Filters Clear All
~ Location

[ Bellevue, DC. United States (8)
[ A, United States (2)
[ united States (1)

~ Work Locations
[ corporate Ha (11)

A Job Family
[ TEST_JOB_FAMILY_CONV (3)
[ executive (0

[ professional (1)

A Organization

[ camptra Org (11)

~ Posting Dates
® A1)
_ Today (0)
) Less than 7 Days (0)
) Less than 30 Days (0)
2 Greater than 30 Days (11)

PA HRIS Manager (54)
Bellevue, DC, United States

Hiring Manager
Burke, Michael

NK-Associate Consultant (47)
Bellevue, DC, United States

Hiring Manager
Burke, Michael

HRIS Manager (33)

Bellevue, DC, United States

Hiring Manager
Burke, Michael

Solution Specialists (1)
Bellevue, DC, United States

Hiring Manager
Saini, Aditya

O Hide Filters Search Radius 25 Miles ®

Click Job Title

Organization
Camptra Org

Organization
Camptra Org

Organization
Camptra Org

Organization
Camptra Org

Here the employee can view the Job Details. To apply,

HRIS Manager

33

<

Job Info

Crganization
Camptra Crg

Locations
Bellevue, DC. United States

Work Locations
Corporate HQ

Posting Dzte
1179721

Job Detai's

Organization Description

We would ke to welcome you 1o join aur team and help us take our business marifolds zhead

Employer Description

We a: Camptra Technologies started our joumey in Z01€ zs 2 team of szasoned software engineers and tachnolcgy specialists, Today, we use our comained ecgertie to provice solutions that

are notonly optimal for your dusiness but also cost-effective ard pecple-oriented.

Our tezm of top-notch consultznts have 3 ccmbinec experience of 75 years in the Oraclz solutior space. As trusted wp ementtion partners for basiness, we beleve that open communication
with our clients is the key to developing relevant solutions. We focus, therefore, on working with you 2very step of the way to des gn sclutions trat zre efficient, cynamic anc scalable so that

your business always keeps pace ith incustry changes.

Job Description

Posting Visibility
Internal and

1o Shift
Day

Full or Part Time
Full ime

ternal

click Apply

Actions | v | Aoply

Click Apply

Enter the requested information in each section and click Continue




Complete Job Application

HRIS Manag

i L AP

A copy of your skills and qualifications will be included with your job application.
Review skills and Qualifications

© Job Application Questions

Ententhe belowjinformation
* Do you have a working visa?

Yes
No

* How will you rate your communication skills?
Excellent
Mediocre

O Novice

* How will you rate your technical skills?
Excellent
Average
Beginner

* How many years of experience do you have in this field?
Less Than 5 Years
5-10 Years
More Than 10 Years

Click Continue

Continue

Click Submit

Complete Job Application

HRIS Manager, 33

. = S _ Click Submit
Lir KL AR % % T

@  Acopy of your skilsand qualfications will be included with your job applicaton.
Review Skills and Qualifications

() Job Application Questions

(@ Supperting Documents

@ t-signature

Please fill in your full name.

“Employee Name

Test Employee

Candidate Management- Create A Candidate
Navigation: My Client Groups>Hiring>Candidate Search>Add>Submit

From the home screen, click My Client Groups

—

]
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Good afternoon, Michael Burke!

roups

Click My Client Groups

QUICK ACTIONS.
Hire an Empl
ontingent Worker
Add a Pending

Pending Wi Goals

ent Contras

Talent Pools
Location
Change Working Hours

+

Promote

Click Hiring

Joumeys

&l

Performance

&8y

Workforce
Structures

Good afternoon, Michael Burke!

/ Team My Client Groups

QUICK ACTIONS.
Hire an Emplos
Add a Contingent Worker
Add a Pending Worl
Add a Nonworker

Pending Workers

Talent Pools

Change Location
ange Working Hours

4‘,

Promot

Click Candidate Search

Journeys

Click
il

Performance

4

Workforce
Structures

Help Desk My En

\%*

New Person

Person Absences

Management

(@] el

AC=d|

Talent Review Succession Plans

—
] ) &=
Waorkforce Data Exchange

Mass Updates
Modeling

Enterp

O *

[B4]

New Person

erson
Management

(e lje]

Cs=]

Talent Review ccession Plans

i} 23 =

Data Exchange

Workforce

Mass Updates
Modeling

>




Job Requisitions

I

Requisitions
Job Requisitions
Show Fiters | | HiingTeam Role | Recuter, Hiing Manager, Collbarstor

Candidate Search

<1 campaigns Click Candidate Search  SHESWRIvEY

PoSting - In Progress

{3 candidate Pools Standard
United States

& sovortes Solution Specialists PA (65) Applications: 0
Open - Posted Prospects: 0
Standard

Bellevue, DC, United States

PA_test1 (64) Applications: 0
Open - Posted Prospects: 0
Standard

United States

Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

Network Specialist-NK (57) Applications: 3
Open - Posted Prospects: 0
Standard

CA Loited iatec

Click Search

Candidate Search

L Ll

Click Search

Search Action | Search for Candidates

Job Requisitions

e Candidate Search

< campaigns

| Candidate Pools Keyword Searcn

% Job Offers

| Search using keywords or boolean expressions

Examplas of search expressions: project manage, bus nsss analyst NOT manager, marketing manager AND [campa gns OR commurications)

Candidate Datals ¥ oad v

-

,( There s nathing here so far.

Location + Add v

Click Add

]
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{ Candidate Search

IV LG,

Candidates (48)
Click Add
ShowFilters
| Actionsv | & View ‘ Summary v ‘ Sort By | Relevance v ‘
Candidate Details Education Experience Work Preferences

[] Mukherjee, Rishi
3004
Yorba Linda, CA US

[] Jones. Albert
3003
Yorba Linda, CA, LS

[] Kumar, Ravi B
3019
Yorba Linda, CA, US

[] Albert Moon, JefiCon
3013

Yorba Linda, CA, US

[] Bosee, Jayanta B
3018

Enter the Basic Information and click Save and Close

Create Candidate

Save and Close

Click Save and Close

Basic Info Entersthe belowjinformation
“Last Name Ttle
‘ Candidate ‘ ‘ Ms. v
First Name Middle Name
‘ Test ‘ ‘ Megan ‘
Email Source
‘ testcandidate@gmail.com ‘ Resume Handed in Parson
Display Data fo
Phone Number Display Data to Candidate Candidete

e

‘ 228-7585 ‘ Yes v

Attachments

k< Drag files here or click to add attachment v

Enter the candidate’s name in the Keyword Search and click Search

]
13 |
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Candidate Search

k) B PRVISTED. 8 N B 3 i 7
l€ Click Search

Search for Candidates v

= Search Action
D Job Requisitions

4*

Total Candicates

| Cancidate Pools <eyword Search

=
{=) Job Offers ‘M

Examples of searcn axpressions: preject manager, busiress analyst NOT manager, markezing manager AND (campaigrs OR communicaticns)

Candicate Details [ +ha v

-

’ There's nothing here so far.

Click the Candidate Name

{ Candidate Search

PV P, o

Candidates (4%) [+ naa |

Show Filters

| Actions | @ View | summary v ‘Sm By ‘ Relevance v ‘

Candidate Details Education Experience Work Preferences

[] Test-NK
38011

19002

Click Candidate Name

[] NK-Keerthana Consider Temporary Assignment ..,
Consider Part Time Work
31007 Wark 2 Fleble Schedule

Yorba Linda, CA US

[ Nk Bachelor of Engineering, Vaagdevi  Test Centre Administrator, K Travel Domestically
Engineering College Willing to Relocate
800 Consider Temporary Assignment
Hyderabad, IN Consider Part Time Work

Work a Flexible Schedule

Click Add to add the details of each section

]
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Key Highlights PY
Details
Last Contacted Candidate Number
02 Acivity 117 Days Ago (Sent E-Mail 19002
X Duplicate Check
Candidate Type

External Candidates

| As of 1/17/22
ﬂ Attachments

P2 interactions

Licenses and Certifications + |
E Messages e

, There's nothing here so far.
,a Screening

[

Degrees

A%t Similar Candidates

Languages

Follow this same process to complete each section of the Details to create the
Candidate Profile

( Test Trevor (19002)

PRVBR T

@omn; Key Highlights K

Last Contacted Candidate Number

::l' Activity 117 Days Ago (Sent E-Mail) 19002
Dupiicate Chedk

Candidate Type

External Candidates | 8s of /17,22
P atachments
P2 Interactions —

Licenses and Certifications [[#aaa ] A
B VMessages -
, There's nothing here so far.

,Q Scrzening
O o

, There's nothing here so far.

Managing The Candidate Profile

Navigation: My Client Groups>Hiring>Candidate Search>Select Candidate>View
and Update Candidate Profile

44 similar Candidates

From the home screen, click My Client Groups

]
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Good afternoon, Michael Burke!

roups

Click My Client Groups

QUICK ACTIONS.
Hire an Empl
ontingent Worker
Add a Pending

Pending Wi Goals

ent Contras

Talent Pools
Location
Change Working Hours

+

Promote

Click Hiring

Joumeys

&l

Performance

&8y

Workforce
Structures

Good afternoon, Michael Burke!

/ Team My Client Groups

QUICK ACTIONS.
Hire an Emplos
Add a Contingent Worker
Add a Pending Worl
Add a Nonworker

Pending Workers

Talent Pools

Change Location
ange Working Hours

4‘,

Promot

Click Candidate Search

Journeys

Click
il

Performance

4

Workforce
Structures

Help Desk My En

\%*

New Person

Person Absences

Management

(@] el

AC=d|

Talent Review Succession Plans

—
] ) &=
Waorkforce Data Exchange

Mass Updates
Modeling

Enterp

O *

[B4]

New Person

erson
Management

(e lje]

Cs=]

Talent Review ccession Plans

i} 23 =

Data Exchange

Workforce

Mass Updates
Modeling

>




Job Requisitions

I

Requisitions
Job Requisitions
Show Fiters | | HiingTeam Role | Recuter, Hiing Manager, Collbarstor

Candidate Search

<l campaigns Click Candidate Search ¥} Specialist (75)

PoSting - In Progress

{3 candidate Pools Standard
United States

& soboters Solution Specialists PA (65) Applications: 0
Open - Posted Prospects: 0
Standard

Bellevue, DC, United States

PA_test1 (64) Applications: 0
Open - Posted Prospects: 0
Standard

United States

Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

Network Specialist-NK (57) Applications: 3
Open - Posted Prospects: 0
Standard

CA Loited iatec

Enter the Candidate’s name and Click Search

Candidate Search

Click Search

=] JobRequisitions

'I Campaigns

3

Total Canddates

D candidate Pools Keyworc Search

Sz

sarah Chapman| ]

Examples of seatch exoressions: project manager, business anlyst NOT manager, marketing manager AND (campaigns OF communicaticns)

Enter Candidate's Name

Cancidate Details + Add v

, There's nothing here so far.

Location + hdd v

Click Candidate

]
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Candidate Search

Candidates (3%)
Show Filters.
[ Actions v |

Candidate

Chapman, Sarah

8002

Click Candidate

Columbus, OH, US

[ Chapman, Sarah
23004

Columbus, OH, US

PR TR, &

Details

Resume

Resume:

Education

Master of Business Admin, OH
State U-Columbus

Bachelor of Science, OH State U-
Columbus

@ View | Summary

- ] sortBy [Retevance v

Experience

Solution Specialist, Amazon,
1/1/10 - Present

Solution Specialist, Amazon,
1/1/10 - Present

Product Specialist, Exxon Mobile,
3/1/08 - 1/31/10

Work Preferences

Consider Temporary Assignment
Consider Part Time Work
Work  Flexible Schedule

Consider Temporary Assignment
Consider Part Time Work
Work a Flexible Schedule

[ Chapman, Sarahh
5001

Yorba Linda, CA US

Consider Temporary Assignment
Consider Part Time Work
Work 2 Flesible Schedule

We are now in the Candidate Profile screen. On the left, we can view the
Candidate’s details, applicant activity, attachments, etc. Once we select a tab, the
information within the tab will populate on the screen. We can view and manage
the information by clicking Add or the Pencil Icon to Edit

02 Activity
& Machmenss
B interactions
B Messages
ﬂ! Screening

ﬂ Extra Info

W Simar Candidates

VIV ERTEIY &

Viewiand|Manage)the)Candidate Rrofile)Information Below

Key Highlights

Recent Position
Solution Specialist, Amazon, 12 Years

Recent Education
Master of Business Admin. OH State U-Columbus

Last Contacted
212 Days Ago (Sent E-Mail)

Licenses and Certifications

Degrees

Candidate Quick Search
Navigation: My Client Groups>Hiring>Candidate Search>Enter Candidate Name

Locaticn
Columbus, OH, US

Candidate Type
Extemal Candidates
Candidate Numbsr
8002

‘ + Add ‘ A

M

, There's nothing here so far.

From the home screen, click My Client Groups

]
18 |
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Good afternoon, Michael Burke!

roups

Click My Client Groups

QUICK ACTIONS.
Hire an Empl
ontingent Worker
Add a Pending

Pending Wi Goals

ent Contras

Talent Pools
Location
Change Working Hours

+

Promote

Click Hiring

Joumeys

&l

Performance

&8y

Workforce
Structures

Good afternoon, Michael Burke!

/ Team My Client Groups

QUICK ACTIONS.
Hire an Emplos
Add a Contingent Worker
Add a Pending Worl
Add a Nonworker

Pending Workers

Talent Pools

Change Location
ange Working Hours

4‘,

Promot

Click Candidate Search

Journeys

Click
il

Performance

4

Workforce
Structures

Help Desk My En

\%*

New Person

Person Absences

Management

(@] el

AC=d|

Talent Review Succession Plans

—
] ) &=
Waorkforce Data Exchange

Mass Updates
Modeling

Enterp

O *

[B4]

New Person

erson
Management

(e lje]

Cs=]

Talent Review ccession Plans

i} 23 =

Data Exchange

Workforce

Mass Updates
Modeling

>




Job Requisitions

le

Requisitions
Job Requisitions

‘Kﬁ‘ywo'ﬁ Q] ShowFilters | | HifingTeam Role Recruiter, Hiring Manzger, Collaborator X

< |candidate Search
SortBy | Creation Date - New to Ok ~ |

Click Candidate Search

Campaigns Network Specialist (75)
Posting - In Progress
{3 cancidate Pools Star

Urited States

Job Offers Solution Specialists PA (65) Applications; 0
e d Prospects: 0

Open - Posted

PA_test! (64) Applications: 0
Open - Posted Prospects: 0

Network Specialist-NK (60) Applications: 3
n - Posted Prospects: 0

Urited States
Network Specialist-NK (57) Applications:3
Open - Posted Prospects: 0

Clear [ Search

I A P p T AP .
e e ) ; Click Search

Search Action ‘ Search for Candidates b

le

D Job Requisitions

Candidate Search

Campaigns

LEU Candidate Pools Keyword Search

Search

B Jonotes [2rah Chapman | |

e ples of search expressions:project menager, ousiness analst NOT manager, marketing manager AND (camasigns OR communicarions)

Candidate Details + v |

, There's nothing here so far.

Here we can view the results of the Candidate Search

]
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Candidates (3*)

Show Filters

[ Actions v |
Candidate
[7] Chapman, Sarah
8002

Columbus, OH, US

[] Chapman, Sarah
23004

Columbus, OH, US

[ Chapman, Sarahh
5001

Yorba Linda, CA, US

Details

Resume

Resume

Education

Master of Business Admin, OH
State U-Columbus

Bachelor of Science, OH State U-

Columbus

®  View | Summary

v ‘ Sort By ‘ Relevance v

Experience

Solution Specialist, Amazon,
1/1/10 - Present

Solution Specialist, Amazon,
1/1/10 - Present

Product Specialist, Excon Mobile,

3/1/08 - 1/31/10

Work Preferences

Consider Temporary Assignment
Consider Part Time Work
Work a Flexible Schedule

Consider Temporary Assignment
Consider Part Time Work
Work a Flexible Schedule

Consider Temporary Assignment  wu.
Consider Part Time Work
Work a Flexible Schedule

Create Candidate Pool
Navigation: My Client Groups>Hiring>Candidate Pools>Add>Save and Close

From the home screen, click My Client Groups

Good afternoon, Michael Burke!

My Team
QUICK ACTIONS

Hire an Emplos

Add a Pending Worker
Add a Nonworker
Pending Workers
Person
Employment Contract:
Change Location

ing Ho

Promote

Click Hiring

My Client Groups

Talent Pools

+

Click My Client Groups

Journeys

il

Performance

&

Workforce
Structures

O *

[ixd]

New Person

B

Mass Updates

Help Desk

Person
Management

Talent Review

a2

Waorkforce
Modeling

My Ent:

Succession Plans

=3

Data Exchange




Good afternoon, Michael Burke!

Me My Team My Client Groups Benefits Admir es rvice <now e Help De: My Enterp »

QUICK ACTIONS

Hire an Emplc

O *

ontingent Worker
Journeys New Persan Person
Management

Add a Pending Worker
Click Hiring

Add a Nonworker = o0
el =)

Pend e Performance Telent Review Succession Plans

Person

o 587 i} a8 =

Talent Pools Workforce Mass Updates Workforce Data Exchange
ange Location Structures Modeling

ange Working Hours

Promote

le

Requisitions
Job Requisitions
ShowFiters | Hing Team o Recute g Maniger Collbortor

Candidate Search

< Campaigns Network Specialist (75)

Posting - In Progress

Candidate Pools Standard

United States

Job Offers Solution Specialists PA (65) Applications: 0 -
Click Candidate Pools  [ERCEEIRERES Prospects: 0

Standard

Bellevue, DC, United States

PA_test! (64) Applications: 0
Open - Posted Prospects: 0
Standard

United States

Network Specialist-NK (60) Applications: 3 .
Open - Posted Prospects: 0
Standard

CA, United States

Click Add

]
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Candidate Pools

le
= Pools + a |
B Job Requisitions
o lf,VWWS Ol ShowFilters
~{Candidate Search
| Actons | SortBy | Candidate Pool Name - At v
L“"H S 0 Global Talent Community Pool 16 New
Global, Talent Community Pool 16 Total
Candidate Pools
% Job Offers

Enter the Pool Name, Description, and Ownership Type. If the Ownership Type of
private is selected, only the owner of the Candidate Pool can access the pool. If the
Ownership Type of shared is selected, other users can access the Candidate Pool
and take action. If we select the checkbox for Talent Community Pool, as
candidates apply, they will be automatically added to this pool based on location,
job family, or candidate type. If we do not select the check box, candidates will need

to be added manually to the Candidate Pool

Create Candidate Pool

Pool Info

“Pool Name

Human Resources

Enter Pool Name Description

This pool contains applicants that are interested in HR positions vith our company.

QOwnership Type
®) Private
() Shared
U Global

Enter Description

E alent Community Pool

Select Talent Community Pool, if applicable

Once complete, click Save and Close

]
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(Create Candidate Pool

Click Save and Close

Pool Info

“Pool Name

‘ Human Resources

Description

This pool contains applicants that are interested in HR positions with out company.

Qwnership Type
® private
O shared
O Global

D Talent Community Pool

Review Candidate Files
Navigation: My Client Groups>Hiring>Candidate Search>Select
Candidate>Attachments

From the home screen, click My Client Groups

Good afternoon, Michael Burke!

My Team My Client Groups Benefits Administration Sales Service no Help Desk My Enterp 3

QUICK ACTIONS Click My Client Groups

& Hire an Employee
O * Qe
Journeys New Person Person
Management

nt Worker
Add a Pending Worker

*  Add a Nonworker = @ jelle]
5 sl Clay )

Hendily e Performance Talent Review Succession Plans

By Employment Contracts \% @ gg 3 <::>

Talent Pools Workforce Mass Updates Workforce Data Exchange
Structures Modeling

Change Location

hange Working Hours

Promote

Click Hiring




Good afternoon, Michael Burke!

Me My Team My Client s 3 ts A t s r Know Help Desk My Enterg
QUICK ACTIONS

Hire an Emplar
9 oy
Journeys New Person Person

Management

ntingent Worker
Add a Pending W«
Click Hiring

Add a Nonworker = o0
el =)

Pending Ve Performance Telent Review Succession Plans

Talent Pools Workforce Mass Updates Workforce Data Exchange

T nearan Structures Modeling

nge Working Hours

+

le

Requisitions
Job Requisitions
snow Fiters | | Firing Team Role | Recrter, Hiring Manager, Colborator

andidate Search

1 campaigns Click Candidate Search % Specialist (75) Applications: 0
Posting - In Progress Prospects: 0

{3 candidate Pools Standard
United States

Job Offers Solution Specialists PA (65) Applications: 0
Open - Posted Prospects: 0
Standard

Bellevue, DC, United States

PA _test1 (64) Applications; 0
Open - Posted Prospects: 0
Standard

United States

Network Specialist-NK (60) Applications: 3
Open - Posted Prospects: 0
Standard

CA, United States

Network Specialist-NK (57) Applications: 3
Open - Posted Prospects: 0

Standard

T

Enter the Candidate’s name and Click Search

]
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Candidate Search

Click Search

— Search Acticn | Search for Candidates v
=| Job Requisitions

e Candidate Search
3

_ Total Carddates
[ r—

) Candidate Pools Keyworc Search

Seartn

‘% Job Offers

Sareh Chapmarl |

Examples of search exaressions: poject manager, business analyst NOT manager, marketing manager AND (ampaigns OR commurications)

Enter Candidate's Name

Cancidate Details B

-~

, There's nothing here so far.

Locatior + hdd v

Click Candidate

Candidate Search

VIR, 4
Candidates (3%) \ + Add \
Show Filters

[ Actions v | @ View | Summary v ‘Sor‘tBy‘Rs\svm(e v|

Candidate Details Education Experience ‘Work Preferences

1| chapman, sarah Resume Master of Business Admin, OH  Solution Specialist, Amazon, Consider Temporary Assignment
— State U-Columbus 1/1/10 - Present Consider Part Time Work

¢ Work 3 Flexible Schedule
Click Candidate Columbus, OH, US

[ Chapman, Sarah Resume Bachelor of Science, OH State U~ Solution Specialist, Amazon, Consider Temporary Assignment
o0 Columbus 1/1/10 - Present Consider Part Time Work
Work s Flexible Schedule
Columbus, O, US Product Specialst, Exxon Mobile,
Columbus OF S 3/1/08 - 1/31/10

[] Chapman, Sarahh Consider Temporary Assignment

5001

Yorba Linda, CA US

Consider Part Time Work
Work a Flexible Schedule

We are now in the Candidate Profile screen. On the left, we can view the
Candidate’s details, applicant activity, attachments, etc. To view the candidate’s
files, click Attachments

]
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Sarah Chapman (8002)

@ Key Highlights ~
Details

Recent Fosition

Location
2 actiity Solution Specialist, Amazon, 12 Years

Columbus, OH, US
Recent Education

Candicate Type
Master of Business Admin, OH State U-Columbus

Extemal Candidates

?

Attachments | Last Contacted Candicate Number

212 Days Ago (Sent E-Mail] 8002

P2 interactons Click Attachments

B Messages Licenses and Certifications +ad | A

,a Screening , There's nothing here so far.

® cazinto

184 Similar Candidates Degrees

Languaces

We can now view the Candidate Files. To view a file, click Document Name and we
canview the file

Sarah Chapman (8002)
B o L d Lt R
le
Supporting Documents A~
M Details

= View | List -
2 Activity

@ Attachments
‘ Drag files here or click to add attachment v

P2 interactions

B Messages S. Chapman Resume.docx %, Resume X ¢

S. Chapman Resume.docx
Click Document Name
A Sscreening

O owainn

Internal Documents

k< Drag files here or click to add attachment v

iM% Similar Candidates

Reject A Candidate

Navigation: My Client Groups>Hiring>Select Applications>Select
Candidate>Move>Reject

From the home screen, click My Client Groups

—

]
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Good afternoon, Michael Burke!

QUICK ACTIONS.

Hire an Empl
tingent Worker

Add a Pending Worker

Pending W

Person

Employment Contra
ange Local

Change Working Hours

[y Promote

Click Hiring

fits Adminis

Click My Client Groups

Goals

Talent Pools

+

Joumeys

&l

Performance

&8y

Workforce
Structures

Good afternoon, Michael Burke!

My Client Groups

QUICK ACTIONS

Hire an Employ

ntingent Worker

Add a Pending Worker

Add a Nonworker

Pending Wo

Person

Employme

Change Location

nge Working Hours

Benefits Admin

Talent Pools

4‘,

ation

Journeys

Click Hiring

&l

Performance

4

Workforce
Structures

O *

[id]

New Person Person

Management

Talent Review

] 83

Mass Updates Warkforce

Modeling

O *

[B4]

New Person Person
Management

Talent Review

) Py}

Mass Updates Workforce
Modeling

Click Applications across from the Requisition

My En

Absences

(@] el

AC=d|

Succession Plans

=

Data Exchange

Help Desk

(e lje]

Cs=]

ccession Plans

=

Data Exchange




Job Requisitions

le
Requisitions \ + Add
Job Requisitions
~ ‘Keywwdx Show Filters | ~ Hiring Team Role  Recruiter, Hiring Manager, Collaborator X
Candidate Search —
Sort By | Creation Date - New to Ol v
1 campaigns Network Specialist (75)
Posting - In Pregress rospect:
Candidate Pools Standard
United States
B Job Offers Solution Specialists PA (65) Applications: 0

Open - Posted Prospects: 0

jard

Bellevue, DC, United States

PA_test] (64) Applications: 0
Open - Posted Prospects: 0

Network Specialist-NK (60)

Open - Posted Prospects: 0

Click Applications

CA, United States

Network Specialist-NK (57) Applications: 3

Open - Posted Prospects: 0

i LS

Job Applications

| Candidate Name or Number | Show Filters |  Application Detals Active X
O [ Actionsv | ) @ View | Summary ] sort By [ create Date - Newto v
Candidate Details Status Education Experience >
& Screening, To be Reviewed Bachelor of Science Network Consuitant, Ifosys .
i, &
Click Candidate Name
[] @ Keerthi-01 Resume Offer, Accepted Master of Science, California State  Network Consuitant Tata
University Consultant Service, 9/1/16 -
36025 M Prescreening score: 10 out of 10 Y : !
resent
Darrington, CA, US
© NK-Keerthana 5 Offer, Accepted Master of Science Tata Consultant Service - Present .,
&

31007

Yorba Linda, CA US

Click Move




Network Specialist-NK (60)

Nancy (39009)

Click Move
1«
Key Highlights &
@ Details
Phase and State Cancicate Number
. Screening, To be Reviewed 39009
7 Activity
{ Candidate Type When Apolying Duplicate Check
External Candidates |Asof 3/3/22
' progress
Attachments I -
¢ Licenses and Certifications B
B2 interactions &
, There's nothing here so far.
B Messages
B auestions . )
Degrees v
B interviews
Languages v
B feedback
A saceing \Work Requirements v

From the State dropdown, click Rejected by Employer and enter the Rejection
Reason

Move Candidate

Network Specialist-NK (60)

Candidates (1)

Detalls

Phase

State

‘ Screening v

Comment

Did not meet minimum qualifications

Rejected by Employer v

Click Rejected by Employer

Enter the Rejection Reason 4

Click Save and Close

—

]
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Move Candidate
Network Specialist-NK (60)

A

Save and Close

Click Save and Close g

Candidates (1) v
Details

Phase State

‘S(reen‘mg ¥ Rejected by Employer

Comment

Did not meet minimum qualifications

Progress Candidate From Candidate List
Navigation: My Client Groups>Hiring>Select Requisition>Select Candidate>Move

From the home screen, click My Client Groups

Good afternoon, Michael Burke!
My Team My Client Groups 3enefits Administration Sales (N ge Help Desk My Entere 3

QUICK ACTIONS Click My Client Groups

Person
Management
Add a Pending Worker

Add a Nonworker = [ele]
o sl Cl &)

Penck T Performance e Talent Review Succession Plans

Person

9/ Employment Contracts i \@ (FE @ ==

Talent Pools Workforce Mass Updates Waorkforce Data Exchange
Structures Modeling

Promote

Click Hiring




Good afternoon, Michael Burke!

Me My Team My Client s 3 ts A t s r Know Help Desk My Enterg
QUICK ACTIONS

Hire an Emplar
9 oy
Journeys New Person Person

Management

ntingent Worker
Add a Pending W«
Click Hiring

Add a Nonworker = o0
el =)

Pending Ve Performance Telent Review Succession Plans

Talent Pools Workforce Mass Updates Workforce Data Exchange

T nearan Structures Modeling

nge Working Hours

+

I¢
Requisitions Fiadd
Job Requisitions

Keywords ¢}

Show Filters | | Hiring Team Role | Recruiter, Hiring Manager, Collaborator x
Candidate Search

Sort By | Creat Date - New to Olc v
<1 campaigns Network Specialist (75)

Posting - In Pregress

| Candidate Pools Standard

Uniteg States

Job Offers Solution Specialists PA (65) Applications: 0
Open - Posted Prospects: 0
Standard

Bellevue, DC, United States

PA_testl (64) Applications: 0
Open - Posted Prospects: 0
Standard

United States

Applications: 3

Network Specialist-NK (60)

Open - Posted Prospects: 0
Standad Click Applications

CA, United States

Network Specialist-NK (57) Applications: 3
Open - Posted Prospects: 0

Standard
CA, United States

Click (...) across from the Candidate we wish to progress to the next step

]
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{  Network Specialist-NK (60)

FUHECE T,
Job Applications

| candidate Narme or Number

il ‘ Actions v ‘
Candidate Details

~] Nangy o
39009

7] Keerthi-01 Resume
36025 M
Dorrington, CA, US

] @ NK-Keerthana 3

31007
Yorba Linda, CA, US

From the dropdown, we can progress the Candidates by selecting the next step in

| Show Filters

Application Detais  Active X

Status

Screening, To be Reviewed

Offer, Accepted

Prescreening score: 10 out of 10

Offer, Accepted

the process and following the applicable steps

9 @ View | Summary

Sort By ‘ Create Date - Newto v

Education

Bachelor cf Science

Master of Science, California State

University

Master of Science

Experience

Netuwork Consultant, Infosys

Network Consultant, Tata
Consultant Service, 9/1/16 -
Present

Tata Consultant Service - Present

>

{  Network Specialist-NK (60)

. & PV T

Job Apolications

] Candidate Name or Number O, | Show Filiers
L | Actorsv |
Candidate Details
[C  Nancy &
35009
[ Keerthi-01 Resume
36025 &

Dorington, CA, US

[ ® NK-Keerthana

3:007

Ee

Yorba Linda, CA, US

Offer Creation

Application Decails

Active X

status

Screening, o be Revievied

Offer, Accepted

Prescreening score: 10 out of 10

Offer, Accepted

Q @ View | Summary

| ort By | create Date - New to v

Education

Bachelor of Science

Master of Science, California State
University

Master of Science

Experience >

Network Consultant, nfosys

Network Consultant, Tata
Consultant Senvice, 9/1/16
Present

Send Message
Send Message to Team
Collect Feadback

Create Job Offer

Tata Consultant Service - Present

Navigation: My Client Groups>Hiring>Select Applications>Select
Candidate>Actions>Create Job Offer

From the home screen, click My Client Groups

—
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Good afternoon, Michael Burke!

QUICK ACTIONS.

Hire an Empl
tingent Worker

Add a Pending Worker

Pending W

Person

Employment Contra
ange Local

Change Working Hours

[y Promote

Click Hiring

fits Adminis

Click My Client Groups

Goals

Talent Pools

+

Joumeys

&l

Performance

&8y

Workforce
Structures

Good afternoon, Michael Burke!

My Client Groups

QUICK ACTIONS

Hire an Employ

ntingent Worker

Add a Pending Worker

Add a Nonworker

Pending Wo

Person

Employme

Change Location

nge Working Hours

Benefits Admin

Talent Pools

4‘,

ation

Journeys

Click Hiring

&l

Performance

4

Workforce
Structures

O *

[id]

New Person Person

Management

Talent Review

] 83

Mass Updates Warkforce

Modeling

O *

[B4]

New Person Person
Management

Talent Review

) Py}

Mass Updates Workforce
Modeling

Click Applications across from the Requisition

My En

Absences

(@] el

AC=d|

Succession Plans

=

Data Exchange

Help Desk

(e lje]

Cs=]

ccession Plans

=

Data Exchange




le

@an Requisitions

Candidate Search
ampaigns
1 campaig

Candidate Pools

B Job Offers

Job Requisitions

Requisitions

[ Keyworss

Network Specialist (75)
Posting - In Pregress

Sta

d

Uniteg States

Solution Specialists PA (65)
Open - Posted

jard

Bellevue, DC, United States

PA_test] (64)
Open - Posted

Network Specialist-NK (60)
Open - Posted

CA, United States

Network Specialist-NK (57)
Open - Posted

Show Filters

Hiring Team Role

Recruiter, Hiring Manager, Collaborator X

Applications: 0
Prospects: 0

Applications: 0

Prospects: 0

Prospects: 0

Applications: 3
Prospects: 0

Click Applications

‘ + Add

Click Candidate Name

i LS

Job Applications

| candidate Name or Number 9| ShowfFilters
O [ Actionsv |
Candidate Details.
o
5 &
[] @ Keerthi-01 Resume

36025 &

Dorrington, CA,US

@ NK-Keerthana

Be

31007

Yorba Linda, CA US

Click Actions and Create Job Offer

Application Details

Active %

Status

Screening, To be Reviewed

Offer, Accepted

Prescreening score: 10 out

Offer, Accepted

) @ View | summary

| sort by [ create Date - Newto v

Education

Bachelor of Science

Master of Science, California State

g University

Master of Science

Experience >
Network Consultant, Infosys P
Network Consultant, Tata e
Consultant Service, 9/1/16 -

Present

Tata Consultant Service - Present ...




Network Specialist-NK (60)

Nancy (39009)

Returr to Prir Phase

le
Addto Requistion
Key Highiights
@ ST addto Canddate Pool
Phase and State Candidate Number Add nteraction
o Screening, To be Reviewed 35009 Sond Wessage
£ Actvity . ’
Candidate Type When Applying Duplicate Check Sond Message 1o Team
External Candidates
| As of 8/3/22

& progress

Collet Feecback

Chesk Duplcaes
& nachments

Licenses and Cerificetions

Calculats Computed Fields

P2 interactions g

, There's nothing here so far.

Click Create Job Offer

B Messages
B auestions Degraes :
B interviews
- > < v
Languages
B Feedvack
A saeening Work Requirements N

0 <uue me. Q)
Select the applicable options and click Continue

Create Job Offer

Nancy (39009), 60

Click Continue

Select the Applicable Options Below

What would you like to do while working on this job offer?

‘ Offer Team ’

Salary ’

Other Campznsation ’

Comments and Atachments ’

Additional Info Offer Letter

Enter the When and Why details and click Continue

—

]
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Create Job Offer

Nancy (39009), 60

FEUTE.

When and Wh i
@ \when and Why Enter the Below Information

“When is the employee start date? “Action

[s26722 ] [ Add Pending Worker v

“Legal Employer

[eRPwebTutor UsA Inc. v
“Worker Type
[employee v ‘

Click Continue

3) Offer Tean

Create Job Offer Soveand Coss

Nancy (39009), 60
: Click Submit

Hoir L LR %5 EVIRTIT. & mon
(1) Additiona Info it |

© Orfer Letter

Offer Letter
‘Offe\ Letter Template v
Download
k‘ Drag files here or click to add attachment

Candidzte Job Application Language Expiration Date

AmeicanEngsh iy &

Additional Text 1

Extend Offer To Candidate
Navigation: My Client Groups>Hiring>Select Applications>Select
Candidate>Actions>Extend Offer

From the home screen, click My Client Groups

]
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Good afternoon, Michael Burke!

QUICK ACTIONS.

Hire an Empl
tingent Worker

Add a Pending Worker

Pending W

Person

Employment Contra
ange Local

Change Working Hours

[y Promote

Click Hiring

fits Adminis

Click My Client Groups

Goals

Talent Pools

+

Joumeys

&l

Performance

&8y

Workforce
Structures

Good afternoon, Michael Burke!

My Client Groups

QUICK ACTIONS

Hire an Employ

ntingent Worker

Add a Pending Worker

Add a Nonworker

Pending Wo

Person

Employme

Change Location

nge Working Hours

Benefits Admin

Talent Pools

4‘,

ation

Journeys

Click Hiring

&l

Performance

4

Workforce
Structures

O *

[id]

New Person Person

Management

Talent Review

] 83

Mass Updates Warkforce

Modeling

O *

[B4]

New Person Person
Management

Talent Review

) Py}

Mass Updates Workforce
Modeling

Click Applications across from the Requisition

My En

Absences

(@] el

AC=d|

Succession Plans

=

Data Exchange

Help Desk

(e lje]

Cs=]

ccession Plans

=

Data Exchange




Job Requisitions

le

Requisitions
Job Requisitions
‘Keywuldx
Candidate Search
1 campaigns Network Specialist (75)
Posting - In Pregress
Candidate Pools Standard

Uniteg States

B Job Offers Solution Specialists PA (65)
Open - Posted

jard

Bellevue, DC, United States

PA_test] (64)
Open

Posted

Network Specialist-NK (60)
Open - Posted

CA, United States

Network Specialist-NK (57)
Open

Posted

Show Filters

Hiring Team Role

Recruiter, Hiring Manager, Collaborator X

Applications: 0
Prospects: 0

Applications: 0

Prospects: 0

Prospects: 0

Applications: 3
Prospects: 0

Click Applications

‘ + Add

i LS

Job Applications

| candidate Name or Number 0] ShowFiters
O [ Actionsv |
Candidate Details
o
5 &
Click Candidate Name
[] @ Keerthi-01 Resume

36025 &

Dorrington, CA,US

@ NK-Keerthana

Be

31007

Yorba Linda, CA US

Click Actions and Extend Offer

Application Details

Active %

Status

Screening, To be Reviewed

Offer, Accepted

Prescreening score: 10 out

Offer, Accepted

9 View

Summary

| sort by [ create Date - Newto v

Education

Bachelor of Science

Master of Science, California State

g University

Master of Science

Experience >

Network Consultant. Infosys 5

Network Consultant, Tata
Consultant Service, 9/1/16 -
Present

Tata Consultant Service - Present .,




Tes: Trevor (19002)

'TT

l¢

@ Details

£ Activity
B progress
ﬂ Attachments
P2 Interactions
B Messeges
B auestiors
B interviews
B Feecback

A screening

@ canfo

Key Highlights

Phase and State
Offer, Approved

Cancidate Type When Applying
Extemal Candidates

-~

Candidate Number
19002

Duplicate Check

|As of 1/17/22

, There's nothing here so far.

Languages

Work Requirements

Previous Employment

Clck Extend offer Kl

Actions v

addto Requisfion

Addto Candidate Peol

Add Interaction

Send Nessage

Send Nessage to Team
view Invte

Collet Feedback

Check Dupicales

Redraf Offer

Calculate Comauted Fields

Wete offine
Leave a message

Accept Offer On Behalf Of Candidate
Navigation: My Client Groups>Hiring>Select Applications>Select
Candidate>Actions>Accept Offer

From the home screen, click My Client Groups

Good afternoon, Michael Burke!

My Team
QUICK ACTIONS

Hire an Emj

" Add a Pending Worker
Pending Workers

Employment Contracts
1ange Location

\ange Working Hours

Promote

Click Hiring

ly Client Groups

Joumneys

il

Performance

&8y

Workforce
Structures

Talent Pools

+

Service

O *

New Person Person
Management

Talent Review

5 23

Mass Updates Workforce

Modeling

Help Desk

My Enterp &

olie]

C==]

Succession Plans

=

Data Exchange




Good afternoon, Michael Burke!

Me My Team ient Groups Benefits Administratio Sales Service Knowledge Help Desk My Enterp »
QUICK ACTIONS

Hire an Emplos

O *

Add a Contingent Worker 8

Journeys New Person Person
Management

Add a Pending Worker
Click Hiring

‘D&JED Q.9

ot Performance Telent Review Succession Plans

o4 i ) —

Talent Pools Workforce Mass Updates Workforce Data Exchange
Structures Modeling

+

1€

Requisitions Fiadd
Job Requisitions

Keywords ¢}

Show Filters | | Hiring Team Role | Recruiter, Hiring Manager, Collaborator x
Candidate Search

Sort By | Creation Date - New to Olc v

1 campaigns Network Specialist (75)

Posting - In Pregress

| Candidate Pools Standard

Uniteg States

Job Offers Solution Specialists PA (65) Applications: 0
Open - Posted Prospects: 0
Standard

Bellevue, DC, United States

PA_testl (64) Applications: 0
Open - Posted Prospects: 0
Standard

United States

Network Specialist-NK (60)

Applications: 3

Open - Posted Prospects: 0
Standad Click Applications

CA, United States

Network Specialist-NK (57) Applications: 3
Open - Posted Prospects: 0

Standard
CA, United States

Click Candidate Name




Network Specialist-NK (60)

Lir it LD

Job Applications

| Candidate Name or Number | showFiters | | Application Detalls  Actve X
[ | Actions | Q @ View | Summary ] sort By [ reate Date - Newto v
Candidate Details status Education Experiance ’
" Screening, To be Reviewed Bachelo of Science Network Consaltant,Infosys
i &
Click Candidate Name
[ @ Keerthi-01 Resume Offer, Accepted Master ofScenc, Calfomia State  Network Consuitant Tata
: B Universty Consultant Service, 5/1/16 -
36025 B Prescreening score: 10 out of 10 i
Dorrington. CA US
[] ® NK-Keerthana & Offer, Accepted Master of cience Tata Consultant Seniice - Present

31007

Yorba Linda, CA, US

Click Actions and Accept Offer

Network Specialist-NK (60)

Nancy (39009)

Move

‘Add tc Requistion
|(- ‘Add tc Candidate Pool
. ‘Add Irteraction
Key Highlights
@ Details Send Message
Phase and State Candicate Number Send Message to Team
. Offer, Extended 39009
37 Activity
Last Contacted ‘ Duplicate Check Colect Festbact
Tocay (Sent E-Mail) ,
. | As of 8/3/22 Check Cuplicaies
W progress Cancicate Type When Applying

Extemal Candidates Pieview Offer

Raserd Offer

ﬂ Attachments

Licenses and Certifications Calcuts Camputd s

P2 Interactons Click Accept Offer

-~

There's nothing here so far.
B Messages , ~ 9
B auestions
Degrees v
BB mterviews
B reeavack Languages v

A saeering

Move Candidate To HR

Navigation: My Client Groups>Hiring>Select Applications>Select
Candidate>Actions>Move to HR

From the home screen, click My Client Groups

]
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Good afternoon, Michael Burke!

QUICK ACTIONS.

Hire an Empl
tingent Worker

Add a Pending Worker

Pending W

Person

Employment Contra
ange Local

Change Working Hours

[y Promote

Click Hiring

fits Adminis

Click My Client Groups

Goals

Talent Pools

+

Joumeys

&l

Performance

&8y

Workforce
Structures

Good afternoon, Michael Burke!

My Client Groups

QUICK ACTIONS

Hire an Employ

ntingent Worker

Add a Pending Worker

Add a Nonworker

Pending Wo

Person

Employme

Change Location

nge Working Hours

Benefits Admin

Talent Pools

4‘,

ation

Journeys

Click Hiring

&l

Performance

4

Workforce
Structures

O *

[id]

New Person Person

Management

Talent Review

] 83

Mass Updates Warkforce

Modeling

O *

[B4]

New Person Person
Management

Talent Review

) Py}

Mass Updates Workforce
Modeling

Click Applications across from the Requisition

My En

Absences

(@] el

AC=d|

Succession Plans

=

Data Exchange

Help Desk

(e lje]

Cs=]

ccession Plans

=

Data Exchange




Job Requisitions

le
Requisitions \ + Add
Job Requisitions
~ ‘Keywwdx Show Filters | ~ Hiring Team Role  Recruiter, Hiring Manager, Collaborator X
Candidate Search —
Sort By | Creation Date - New to Ol v
1 campaigns Network Specialist (75)
Posting - In Pregress rospect:
Candidate Pools Standard
United States
B Job Offers Solution Specialists PA (65) Applications: 0

Open - Posted Prospects: 0

jard

Bellevue, DC, United States

PA_test] (64) Applications: 0
Open - Posted Prospects: 0

Network Specialist-NK (60)

Open - Posted Prospects: 0

Click Applications

CA, United States

Network Specialist-NK (57) Applications: 3

Open - Posted Prospects: 0

i LS

Job Applications

| Candidate Name or Number | Show Filters |  Application Detals Active X
O [ Actionsv | ) @ View | Summary ] sort By [ create Date - Newto v
Candidate Details Status Education Experience >
& Screening, To be Reviewed Bachelor of Science Network Consuitant, Ifosys .
i, &
Click Candidate Name
[] @ Keerthi-01 Resume Offer, Accepted Master of Science, California State  Network Consuitant Tata
University Consultant Service, 9/1/16 -
36025 M Prescreening score: 10 out of 10 Y : !
resent
Darrington, CA, US
© NK-Keerthana Offer, Accepted Master of Science Tata Consultant Service - Present .,

Ee

31007

Yorba Linda, CA US

Click Actions and Move to HR




Network Specialist-NK (60)

Keerthi-01 (36025)

‘Addto Reuisticn

|@ /Add to Cancidate Posl
- /Add Interzction
@ Key Highlights
" Send Messzge
Details
Phase and State Candidate Number SendMssszge fo Team
N Offer, Acceptad 36025
Fy e
Activit
) y Last Contacted Duplicate Chect

Colect Feedback
175 Days Ago (Sert &-Mail)

o i | As of 4/6/22 Check Dualcates
S progress Candidate Type When Applying
Extemal Candidates Freview Ofer
RetratOffer

% Attachments

Noveto HR

Licenses and Certifications I Cakuae Computed Fecs
2 imeactions Click Move to HR

e ’ There's nothing here sc far.
Wessages

B auestions

Degrees i
B nerviews
B reedvack Languages i

A sceening

Click Yes

Network Specialist-NK (60)

Keerthi-01 (36025)

3
Key Highlights ~
@ Details
Phase and State Candidate Number
N Offer, Accepted 36025
SetEAciviy Last Contacted Dunlicata Caacl.
178 Days Ago (Sent E-Mail) . 22
W progress Candidate Type When Applying i
External Candidates warning
D Avachments You're about o move the candidate Keerth-01 to the HR phase. It
may take a few minutes to complete. Contirue anyway?
Licenses and Certificati @

P2 interactions

B Messages
B auestions

Degrees v
B interviews
B reevack Languages y
A sceening

Work Requirements v
® caanmo

Candidate will be successfully transitioned to HR and can be managed through
quick actions or person management

Thank you for reviewing and using our guide; we hope you have found it helpful. If you have any
questions on the content included in this guide, please contact our Training & Learning team at
learn@camptratech.com

Version Revision
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